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Sage Accpac International, Inc. License Agreement for 
Simply Accounting by Sage Products 

IMPORTANT – PLEASE READ CAREFULLY THE FOLLOWING 
TERMS AND CONDITIONS: 

This Sage Accpac License Agreement for Simply Accounting by Sage Accpac Products (this 
“Agreement”) is a legal agreement between you or the company that you are authorized to 
represent (“You”) and Sage Accpac International, Inc. (“Sage Accpac ”).  This Agreement 
governs your use of the accompanying Simply Accounting computer software programs and all 
documentation (printed and electronic manuals, guides, bulletins and online help) and any 
modifications, updates, revisions or enhancements received by You from Sage Accpac  or its 
dealers (the “Program”).  You acknowledge and accept the terms and conditions of this 
Agreement by installing this computer software. 

IF YOU DO NOT AGREE WITH THESE TERMS, YOU SHOULD IMMEDIATELY CANCEL 
THE INSTALLATION PROCESS AND RETURN THE PACKAGE AND ITS CONTENTS TO 
SAGE ACCPAC IN ACCORDANCE WITH SAGE ACCPAC’S RETURN POLICY. 

Registration and activation of your license for the Program with Sage Accpac is required.  Student 
and Evaluation versions must be registered upon your first use of the Program, otherwise, You 
have thirty (30) days after your first use of the Program to register and activate your product or the 
Program will stop functioning until You register and activate your product. 

1. GRANT OF LICENSE. 

Subject to your compliance with all terms of this Agreement, Sage Accpac hereby grants to You a 
limited, nontransferable, non-exclusive license to use the Program under the terms stated in this 
Agreement for use in your business or profession.  The grant of rights hereunder to the Program is 
not a sale of the Program or any portion thereof and does not convey any rights of ownership in 
the Program.  Sage Accpac reserves all rights not expressly granted by this Agreement and You 
hereby acknowledge that all title and ownership of the Program and all associated intellectual 
property rights are and shall remain with Sage Accpac. 

2. LICENSE RESTRICTIONS. 

You agree to the following restrictions: 

(a) You may not make copies, translations or modifications of or to the Program or any portion 
thereof, except You may install one (1) copy of the Program for backup purposes in support of 
your use of the Program.  You may install a second copy of the Program for use on either (i) your 
home computer; or (ii) a portable computer that You own or use in your business or profession, to 
the extent that such computer is used by You as a secondary computer.  You must reproduce all 
copyright, trademark, trade secret and other proprietary notices on any such copies of the Program.  
All copies of the Program are subject to the terms and conditions of this Agreement. 
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(b) You may not install more than one (1) Program on any Client Device (as defined below). 

(c) If You have licensed a single-user version of the Program, the Program shall be used and 
accessed solely in accordance with a single-user arrangement, which means that the Program and 
any data stored on a local area network is accessed by one user at a time on a total of one 
computer or workstation, or personal digital assistant, pager, “smart phone” or one such other 
electronic device (a “Client Device”), which You own or use in your business or profession and 
for which the Program is designed to operate.  The component parts of the Program may not be 
used individually or jointly in full or in part on more than one Client Device, unless otherwise set 
forth herein. 

(d) If You have licensed a multi-user version of the Program, the Program shall be used and 
accessed solely in accordance with a multi-user arrangement, which means that the Program and 
any data stored on a local area network may be accessed by multiple licensed users concurrently.  
If You have licensed a Multi-user License Pack (the right to install the Program on more than one 
Client Device and the right to access the same data concurrently from more than one Client 
Device, up to a pre-defined limit), You may install the Program on separate Client Devices up to 
the number of licenses that You have purchased, but not more than the pre-defined limit and You 
may access the same data concurrently up to that same number of licenses or predefined limit  
You also have the right to use the multi-user version of the Program on a local area network 
provided the number of Client Devices permitted to access the Program concurrently corresponds 
to the number of licenses You have purchased up to a pre-defined limit.   

 Use of software, hardware or services that bypass any Program license restrictions and/or 
reduce the number of Client Devices, concurrent users and/or seats, as may be applicable, 
accessing or utilizing the Program (e.g., “multiplexing,” “pooling,” or third party add on software 
or hardware) expressly does not reduce the number of licenses required (i.e., the required number 
of licenses would equal the number of distinct inputs to the multiplexing or pooling software or 
hardware “front end”).  If the number of Client Devices, concurrent users and/or seats that can 
potentially connect to the Program exceeds or has the potential to exceed the number of licenses 
You have obtained, then You must have a reasonable self-enforcing automatic mechanism in place 
to ensure that Your use of the Program does not exceed the use limits specified for the license You 
have obtained. 

 Notwithstanding the foregoing, if the Program is hosted under the auspices of an authorized 
Sage Accpac  Hosting Partner, it may be installed on server hardware located at premises under 
the exclusive or primary control of such Hosting Partner or its agent.  You may not use or permit 
any parent, affiliate, subsidiary or any other third parties to benefit from the use or functionality of 
the Program, either directly or via a facility management, timesharing, service bureau or any other 
arrangement; provided, however, that You may use the Program, as provided herein, to process the 
data of an affiliate or subsidiary of which You own more than fifty percent (50%); provided, 
however, You may not exceed the number of datasets specified on the applicable product 
packaging or accompanying documentation. 
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(e) If the Program You have licensed is a Not for Resale version (an “NFR Version”), your 
license is for your individual use and for demonstration, marketing, promotional, end user support, 
training and/or development purposes, each to the extent permitted, and/or required under the 
applicable Sage Accpac Premier Advisor (formerly Solution Provider), Authorized Consultant 
(formerly Certified Consultant) or other applicable agreements between You and Sage Accpac  
(the “Other Sage Accpac Agreements”).  Use of the NFR Version is limited to not more than the 
number of licenses You have acquired.   

(f) If the Program You have licensed is a student version (a “Student Version”), your license 
is solely for your individual use for educational purposes.  Use of the Student Version is limited to 
fourteen (14) months from date of registration. 

(g) If the Program You have licensed is an educational version (an “Educational Version”), 
your license is solely for your use for educational purposes.  Use of the Educational Version is 
limited to the number of licenses that you have acquired pursuant to you Educational Site License 
Agreement. 

(h) If the Program You have licensed is an evaluation version (an “Evaluation Version”), your 
license is solely for your individual use for evaluation purposes.  The Evaluation Version may be 
used for sixty (60) days. 

(i) If the Program You have licensed is the Monthly Service Plan, You agree that Your license 
rights are contingent on Your timely monthly payments of the license fee for the eleven months 
following product registration.  You must provide a valid credit card upon registration to which 
Your eleven monthly payments will be charged.  If Your credit card expires during Your eleven-
month payment period, it is Your responsibility to provide an updated valid credit card.  In the 
event You miss a payment, make a late payment, stop payment or dispute the charge on Your 
credit card before all eleven payments have been made, Your rights under this license agreement 
will terminate and You will be required to immediately stop using the Program.  In addition, Sage 
Accpac  will initiate collections action against you for the balance owed at the time the payments 
stop. Please note that your credit card will continue to be charged after your 11months of 
payments until you cancel your Monthly Service Plan.  

3. LIMITED WARRANTY. 

(a) The following limited warranty applies to You only if You are the original licensee of the 
Program.  Sage Accpac warrants that the Program substantially conforms to the specifications 
contained in the User Guide that was included in the original packaging or is found in the Help 
menu of, your Simply Accounting software (the “Documentation”) for a period of sixty (60) days 
from your purchase, as evidenced by your receipt (the “Limited Warranty Period”), provided 
that the Program is used on the Client Device for which it was designed.  Sage Accpac further 
warrants that the media on which the Program is furnished will be free from defects in material or 
workmanship for the Limited Warranty Period.  Receipt of revisions or upgrades to the Program 
shall not restart or otherwise affect the warranty period for previously delivered copies.  Sage 
Accpac does not represent or warrant that your use of the Program will be uninterrupted or error 
free. 
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(b) Provided You notify Sage Accpac in writing during the Limited Warranty Period of a 
substantial non-conformity between the Documentation and the Program, and if Sage Accpac is 
able to replicate and verify that such substantial non-conformity exists, Sage Accpac shall replace 
or correct the Program, at Sage Accpac’s sole option, so that the Program substantially conforms 
to the specifications or replace the defective media, as the case may be, or You may return all 
copies of the Program and Sage Accpac  shall remit to You the license fee You paid, up to the 
amount of Sage Accpac’s suggested list price for the Program.  This Section 3(b) states your 
SOLE AND EXCLUSIVE REMEDY for any breach of warranty hereunder. 

(c) No employee, agent or representative of Sage Accpac, nor any reseller (including the 
person or company who sold You the Program) or any other third party, is authorized to make any 
warranty with respect to the Program, except those expressly stated in Sections 3(a) and 3(b) of 
this Agreement, and You may not rely on any such unauthorized warranty. 

4. DISCLAIMER OF WARRANTIES. 

(a) The foregoing warranties and remedies are exclusive.  EXCEPT FOR THE EXPRESS 
WARRANTIES PROVIDED IN SECTIONS 3(a) AND 3(b) OF THIS AGREEMENT, THE 
PROGRAM IS PROVIDED ON AN “AS IS” BASIS AND SAGE ACCPAC  DISCLAIMS ALL 
OTHER WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THE PROGRAM 
AND ANY SERVICES FURNISHED IN CONNECTION WITH THIS AGREEMENT.  SAGE 
ACCPAC DOES NOT WARRANT THAT THIS SOFTWARE IS FREE OF BUGS, VIRUSES, 
IMPERFECTIONS, ERRORS, OR OMISSIONS.  SAGE ACCPAC SPECIFICALLY 
DISCLAIMS AND EXCLUDES ANY IMPLIED WARRANTIES, INCLUDING WITHOUT 
LIMITATION: (I) OF MERCHANTABILITY; (II) FITNESS FOR A PARTICULAR PURPOSE; 
(III) OF NON-INFRINGEMENT; OR (IV) ARISING FROM COURSE OF PERFORMANCE, 
COURSE OF DEALING OR USAGE OF TRADE.  IF YOU ARE ACTING AS A CONSUMER, 
SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE 
FOREGOING MAY NOT APPLY TO YOU. 

(b) SAGE ACCPAC SHALL NOT BE LIABLE FOR ANY CLAIMS OR DAMAGES 
CAUSED BY THE OPERATION OF THE PROGRAM ON OTHER THAN THE COMPUTER 
AND OPERATING SYSTEM IDENTIFIED IN THE DOCUMENTATION, ACTS OF ABUSE 
OR MISUSE BY YOU OR MODIFICATIONS OR UNAUTHORIZED REPAIRS.  SAGE 
ACCPAC SHALL NOT BE LIABLE FOR ANY LOSS OR DAMAGE IN CONNECTION 
WITH OR ARISING OUT OF THE INTERRUPTION OR LOSS OF USE OF THE PROGRAM 
OR ANY OTHER ITEMS OR SERVICES PROVIDED BY SAGE ACCPAC. 

(c) YOU ACKNOWLEDGE THAT ANY DATA ENTRY, CONVERSION OR STORAGE IS 
SUBJECT TO THE LIKELIHOOD OF HUMAN AND MACHINE ERRORS, MALICIOUS 
MANIPULATION, OMISSIONS, DELAYS, AND LOSSES, INCLUDING, BUT NOT 
LIMITED TO, INADVERTENT LOSS OF DATA OR DAMAGE TO MEDIA THAT MAY 
RESULT IN LOSS OR DAMAGE TO YOU AND/OR YOUR PROPERTY, AND/OR YOUR 
DETRIMENTAL RELIANCE ON MALICIOUSLY MANIPULATED DATA.  SAGE ACCPAC 
SHALL NOT BE LIABLE FOR ANY SUCH ERRORS, OMISSIONS, DELAYS, OR LOSSES.  



 

5 

 

2006 ENG Simply EULA2.doc, printed on 9/12/2005, at 5:48:19 PM. Last saved on 9/12/2005 
5:38:00 PM. 

ACCPAC INTERNATIONAL, INC. Confidential 

YOU ARE RESPONSIBLE FOR ADOPTING REASONABLE MEASURES TO LIMIT THE 
IMPACT OF SUCH PROBLEMS, INCLUDING BACKING UP DATA, ADOPTING 
PROCEDURES TO ENSURE THE ACCURACY OF INPUT DATA, EXAMINING AND 
CONFIRMING RESULTS PRIOR TO USE, ADOPTING PROCEDURES TO IDENTIFY AND 
CORRECT ERRORS AND OMISSIONS, REPLACING LOST OR DAMAGED MEDIA, AND 
RECONSTRUCTING DATA.  IF YOU LICENSED A STUDENT VERSION, YOU 
ACKNOWLEDGE AND UNDERSTAND THAT:  (I) THE STUDENT VERSION MAY BE 
USED FOR EDUCATIONAL PURPOSES ONLY; (II) THAT THE STUDENT VERSION 
SHALL BE OPERABLE ONLY FOR 14 MONTHS; AND (III) THAT DATA OR OTHER 
INFORMATION USED WITH, PROCESSED BY AND/OR STORED IN CONJUNCTION 
WITH THE STUDENT VERSION MAY BE CONVERTED IF YOU UPGRADE TO THE PRO, 
PREMIUM, OR ACCOUNTANTS’ EDITION OF THE FULL RETAIL PRODUCT UPON 
TERMINATION OF THIS AGREEMENT.  IF YOU LICENSED AN EVALUATION 
VERSION, YOU ACKNOWLEDGE AND UNDERSTAND THAT:  (IV) THE EVALUATION 
VERSION MAY BE USED FOR EVALUATION PURPOSES ONLY; (IX) THE 
EVALUATION VERSION SHALL BE OPERABLE ONLY FOR SIXTY (60) DAYS; AND (X) 
UPON EXPIRATION OF THE EVALUATION PERIOD, ANY DATA OR OTHER 
INFORMATION USED WITH, PROCESSED BY AND/OR STORED IN CONJUNCTION 
WITH THE EVALUATION VERSION MAY BE CONVERTED IF YOU UPGRADE TO THE 
STUDENT VERSION OR THE BASIC, PRO, PREMIUM, OR ACCOUNTANTS’ EDITION OF 
THE FULL RETAIL PRODUCT. 

(d) ANY SAGE ACCPAC PREMIER ADVISOR OR AUTHORIZED CONSULTANT OR 
ANYRESELLER, INSTALLER OR CONSULTANT IS NOT AFFILIATED WITH SAGE 
ACCPAC IN ANY CAPACITY OTHER THAN AS A RESELLER, INSTALLER OR 
CONSULTANT OF SAGE ACCPAC’S PRODUCTS AND HAS NO AUTHORITY TO BIND 
SAGE ACCPAC OR MODIFY ANY LICENSE OR WARRANTY.  SAGE ACCPAC MAKES 
NO REPRESENTATIONS, WARRANTY, ENDORSEMENT OR GUARANTEE WITH 
RESPECT TO THE SKILLS OR QUALIFICATIONS OF ANY SAGE ACCPAC PREMIER 
ADVISOR OR AUTHORIZED CONSULTANT OR ANY RESELLER, INSTALLER OR 
CONSULTANT AND YOU ARE ENCOURAGED TO INDEPENDENTLY INVESTIGATE 
THEIR SKILLS AND QUALIFICATIONS. 

5. DISCLAIMER REGARDING LINKS TO EXTERNAL SITES. 

The Program includes links to other Web sites on the Internet that are owned and operated by third 
parties not under the control of Sage Accpac.  Sage Accpac provides the links for your 
convenience only and does not provide a warranty of any type regarding the actions of such third 
parties or the security of information sent to such third parties while You are using their Web sites.  
Under no circumstances shall Sage Accpac, or its subsidiaries or affiliates, be responsible or liable 
in any way for the availability of services or products offered, or the content located on or through, 
any such third party’s Web site. 

6. EXPORT RESTRICTIONS. 
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You shall abide by all foreign and United States federal, state and local laws, ordinances, rules and 
regulations applicable to the transactions contemplated hereunder.  You agree to comply to the 
extent applicable with the United States Export Administration regulations, the International 
Traffic in Arms regulations and any regulations or licenses administered by the Department of the 
Treasury's Office of Foreign Assets Control 

7. SUPPORT. 

Sage Accpac disclaims any responsibility to provide any customer support except as may be 
agreed under a separate agreement to render support services.  Upon registration of the Program 
You will receive thirty (30) days of free customer support, provided that the Program is registered 
within thirty (30) days of your payment of the license fee, as evidenced by your receipt.  All other 
support requires purchase of a support option, as outlined in any special offers that Sage Accpac 
may from time to time send You, or may be found on the Simply Accounting Web site at 
www.simplyaccounting.com.  Sage Accpac does not provide free customer support for the 
Evaluation Version, NFR Version, Student Version, or versions for Educational Purposes.. 

8. TERMINATION OF SUPPORT AND OTHER SERVICES. 

Software has a limited useful life for various reasons including changes in technology.  You are 
free to decide and responsible for deciding when to upgrade the Program.  Sage Accpac reserves 
the right to terminate Customer Support and all other services applicable to the Program in the 
event that the Program has become inoperable or incompatible with current operating systems, 
hardware, add-on products, product updates and services or other technologies.  To obtain up-to-
date information regarding which products, releases and related services are currently supported, 
contact a customer service representative.  If you are not operating a supported release or service, 
it may be necessary to license an upgrade or replacement product or service in order to continue to 
receive Customer Support and/or other updates.  Any updates licensed by You are considered part 
of the Program and subject to the terms and conditions of this Agreement, except to the extent a 
separate license agreement is provided in connection with such update.  Any replacement products 
or upgrades will be governed by a separate agreement. 

9. OWNERSHIP RIGHTS. 

(a) The Program is protected by United States patent, copyright laws and other intellectual 
property laws, and international treaty provisions.  Sage Accpac and its third party licensors, if 
any, retain all title to and, except as expressly and unambiguously licensed herein, all rights and 
interest in:  (i) the Program, including, but not limited to, all copies, versions, customizations, 
compilations and derivative works thereof (by whomever produced) and all related 
Documentation; (ii) the Sage Accpac trademarks, service marks, trade names, icons and logos; and 
(iii) any and all copyright rights, patent rights, trade secret rights and other intellectual property 
and proprietary rights throughout the world in the foregoing.  You acknowledge that your 
possession, installation, or use of the Program does not transfer to You any ownership, title, or 
registrable interest of any kind to the intellectual property in the Program, and that You will not 
acquire any rights to the Program except as expressly set forth in this Agreement.  You agree that 
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all backup, archival, or any other type of copies of the Program will contain the same proprietary 
notices that appear on and in the Program. 

(b) Should You decide to submit any materials to Sage Accpac via electronic mail, through or 
to Sage Accpac Web site(s), or otherwise, whether as feedback, data, questions, comments, ideas, 
concepts, techniques, survey responses, suggestions or the like, You agree that such submissions 
are unrestricted and shall be deemed non-confidential upon submission.  You grant to Sage 
Accpac and its assigns a non-exclusive, royalty-free, worldwide, perpetual, irrevocable license, 
with the right to sublicense, to use, copy, transmit, distribute, create derivative works of, 
commercialize, display and perform such submissions. 

10. RECOMMENDED ENVIRONMENT. 

This Program has been designed to work optimally in the environment documented within the 
Documentation.  Any defects, inconsistencies or issues arising out of operating outside the 
parameters set forth therein may not be supported by Sage Accpac and may require You to pay 
additional maintenance/upgrade costs to Sage Accpac to rectify. 

11. HIGH RISK ACTIVITIES. 

The Program is not fault-tolerant and is not designed or intended for use in hazardous 
environments requiring fail-safe performance, including without limitation, in the operation of 
nuclear facilities, aircraft navigation or communication systems, air traffic control, weapons 
systems, direct life-support machines, or any other application in which the failure of the Program 
could lead directly to death, personal injury, or severe physical or property damage (collectively, 
“High Risk Activities”).  Sage Accpac expressly disclaims any express or implied warranty of 
fitness for High Risk Activities. 

12. LIMITATION OF LIABILITY. 

BECAUSE SOFTWARE IS INHERENTLY COMPLEX AND MAY NOT BE FREE FROM 
ERRORS, YOU ARE ADVISED TO VERIFY THE WORK PRODUCED BY THE PROGRAM.  
TO THE FULLEST EXTENT PERMITTED BY LAW, SAGE ACCPAC'S LIABILITY TO YOU 
FOR ANY DAMAGES OR LOSSES ARISING HEREUNDER, WHETHER BASED IN 
CONTRACT, TORT OR OTHERWISE, SHALL BE LIMITED TO AND NOT EXCEED THE 
GREATER OF THE AMOUNT OF LICENSE AND SUPPORT FEES PAID BY YOU TO SAGE 
ACCPAC, OR SAGE ACCPAC’S SUGGESTED LIST PRICE FOR USE OF THE PROGRAM.  
TO THE FULLEST EXTENT PERMITTED BY LAW, SAGE ACCPAC SHALL NOT BE 
LIABLE FOR ANY SPECIAL, CONSEQUENTIAL, INCIDENTAL OR INDIRECT 
DAMAGES, INCLUDING BUT NOT LIMITED TO, LOSS OF TIME, LOSS OF GOODWILL, 
LOSS OF CONFIDENTIAL OR OTHER BUSINESS INFORMATION, LOSS OF 
ANTICIPATED PROFITS, REVENUE OR DATA, OR COSTS INCURRED IN CONNECTION 
WITH OBTAINING SUBSTITUTE SOFTWARE, FOR BUSINESS INTERRUPTION, WORK 
STOPPAGE OR COMPUTER FAILURE OR MALFUNCTION EVEN IF SAGE ACCPAC HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.  Sage Accpac will 
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have no responsibility for the Program if any portion of the Program has been modified, lost, 
stolen or damaged by accident, abuse or misapplication. 

13. UNITED STATES GOVERNMENT. 

If the Program is to be provided under a U.S. Government contract, the U.S. government’s right to 
use, modify, reproduce, release or disclose the Program is subject to restrictions set forth in 
subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at DFARS 
252.227-7013 or subparagraphs(c)(1) and (2) of the Commercial Computer Software - Restricted 
Rights at 48 CFR 52-227-19, as applicable. 

14. TERM AND TERMINATION. 

(a) This Agreement shall commence on the date You install the Program and shall continue 
until the earlier of:  (i) the date it is terminated in accordance with the terms herein; (ii) your 
acceptance of a superseding license agreement; or (iii) the expiration of the trial period, if 
applicable. 

(b) This license, and all of Sage Accpac's obligations hereunder, automatically terminate if You 
fail to comply with any provision of this Agreement.  Upon the termination or expiration of this 
Agreement for any reason whatsoever:  (i) the license granted hereunder shall immediately cease; 
and (ii) You shall immediately stop using the Program in any way and, within ten (10) days after 
the effective date of expiration or termination deliver to Sage Accpac, or certify that You have 
destroyed all copies of the Program. 

(c) If You licensed an NFR Version or Educational Version, this Agreement is effective unless 
and until You or Sage Accpac terminates the Agreement in accordance with the terms set forth 
herein or the terms set forth in your Other Sage Accpac Agreements or upon the earlier 
termination or expiration of your Other Sage Accpac Agreements. 

(d) If you licensed a Student Version, this Agreement is effective for a term of fourteen (14) 
months, unless sooner terminated by You or Sage Accpac in accordance with the terms set forth 
herein. 

(e) If You licensed an Evaluation Version, this Agreement is effective for a period 
commencing on the first date the Program is downloaded, installed or first run for a term of sixty 
(60) days, unless sooner terminated by You or Sage Accpac in accordance with the terms set forth 
herein.   

15. MISCELLANEOUS. 

(a) As a user of the Program, You assume the responsibility for the selection of the Program as 
being appropriate for your purposes.  You understand and agree that:  (i) You are solely 
responsible for the content and accuracy of all reports and documents prepared with the Program; 
(ii) using the Program does not relieve You of any professional obligation concerning the 
preparation and review of such reports and documents; (iii) You do not rely upon Sage Accpac or 
the Program for any advice or guidance regarding the appropriate tax treatment of items reflected 
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on such reports or documents; (iv) You will review any calculations made by using the Program 
and satisfy yourself that those calculations are correct; and (v) Sage Accpac's support service is 
designed to offer technical support for issues regarding the features and functionality of this 
Program in the recommended operating environments only.  

(b) To the fullest extent permitted by law and consistent with valid entry into a binding 
agreement, the controlling language of this Agreement is English and any translation you have 
received has been provided solely for your convenience.  In the event You have entered into this 
Agreement by means of the display of a translated version of this Agreement in a language other 
than U.S. English, you may request a U.S. English language version of this Agreement by notice 
to Sage Accpac.  To the fullest extent permitted by law, all correspondence and communication 
between You and Sage Accpac under this Agreement must be in English language.  The exclusive 
judicial forum for any action that You bring to enforce this Agreement shall be an appropriate 
federal or state court located in Georgia.  The exclusive forum for any action that Sage Accpac 
brings to enforce this Agreement shall be an appropriate federal, state or provincial court in the 
state or province, as applicable, in which You have your principal place of business.  In either 
case, this Agreement shall be governed by the internal laws of the forum state without regard to 
the conflict of laws provisions thereof. 

(c) This Agreement allocates risk between You and Sage Accpac as authorized by applicable 
law, and pricing of Sage Accpac’s products reflects this allocation of risk and the limitation of 
liability contained in this Agreement.  In the event that any provision of this Agreement is found 
invalid or unenforceable pursuant to judicial decree, the remainder of this Agreement shall be 
valid and enforceable according to its terms.  

(d) The Sage Accpac logo, Simply Accounting and the Simply Accounting logo are registered 
trademarks or trademarks of Sage Accpac SB, Inc. or its affiliated entities.  For an up-to-date list 
of copyright and trademark statements, refer either to the copyright page of the Program User 
Guide or the Help About Simply Accounting window within the Program.  Other product names 
mentioned may be service marks, trademarks, or registered trademarks of their respective owners 
and are hereby acknowledged. 

(e) No failure or delay of either party to exercise any rights or remedies under this Agreement 
shall operate as a waiver thereof, nor shall any single or partial exercise of the same or other rights 
or remedies preclude any further or other exercise of the same or other rights or remedies, nor 
shall any waiver of any rights or remedies with respect to any circumstances be constructed as a 
waiver thereof with respect to any other circumstances. 

(f) Quebec.  With regard to Quebec, the parties declare that they have required that this 
Agreement and all documents related hereto, either present or future, be drawn up in the English 
language only.  Les parties déclarent par les présentes qu'elles exigent que cette entente et tous les 
documents y afférents, soit pour le présent ou l'avenir, soient rédigés en langue anglaise 
seulement. 

(g) Sections 12 (Limitation of Liability), 14(b) (Term & Termination), 15(b) (Governing Law) 
and this Section 15(g) shall survive the expiration or termination of this Agreement. 
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(h) This Agreement constitutes the entire agreement between You and Sage Accpac with 
respect to the subject matter hereof, and supersedes all proposals, oral or written, and all other 
communications between the parties with respect to such subject matter.  This Agreement shall not 
be modified, except by written agreement signed by the parties hereto.  Sage Accpac shall not be 
bound by or liable to You for any pre-existing or contemporaneous written or oral representations 
or warranties, made by anyone, with respect to the Software Product, including any Sage Accpac 
Premier Advisor or Authorized Consultant or distributor or reseller or their respective agents, 
employees, or representatives. 

(i) Sage Accpac shall not be liable for and shall be excused from any failure to deliver or 
perform or for delay in delivery or performance due to causes beyond its reasonable control, 
including but not limited to, work stoppages, shortages, civil disturbances, terrorist actions, 
transportation problems, interruptions or power or communications, failure or suppliers or 
subcontractors, natural disasters or other acts of God. 

(j) All notices given hereunder shall be in writing and sent by overnight courier or delivered in 
person: (i) if to Sage Accpac, to Sage Accpac, Legal Department, 1505 Pavilion Place, Norcross, 
Georgia  30093; and (ii) if to You, to the address You indicated upon your registration of the 
Program. 

(k) You authorize Sage Accpac to send You information, including but not limited to 
marketing and promotional material, via facsimile, email, telephone, and other reasonable means. 
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Workbook 
 

 

 
The Workbook guides you through the entire process of setting up 
a company’s books and entering common transactions. 
Step-by-step lessons accompany each accounting procedure 
introduced, to give you practice setting up and using the Simply 
Accounting program.  

When you finish the Workbook, you will have a complete set of 
records for a fictional company called Data Processing Services. 
You can use this data for more practice, if you wish. 

If your company uses cash-basis accounting, be sure to read 
Chapter 5, “Cash-Basis Accounting,” in Advanced Topics. 

Backing up Get in the habit of backing up your Simply Accounting data on a 
regular basis, in case your current data becomes damaged. 
Remember that a daily backup will save you a whole day’s 
worth of time and effort. 

Print historical reports 
anytime 

Using the backup copy instead of your current records, you can 
print historical reports even after you start a new month, 
calendar year, or fiscal year. This is useful, for example, if you 
need to print payroll reports as of the end of the calendar year, 
after you have already entered data for a new year. 

For information about backing up your data, see “Backing Up 
Your Company’s Information” in Chapter 19, “Protecting Your 
Data,” in the User Guide. 

Displayed amounts 
and date formats 
may vary 

Note that the screen representations in the Workbook may not 
exactly match your screen because you will probably be using 
different tax tables. The date format may also be different.  

The Workbook uses the MM-DD-YYYY format that can be set in 
Simply Accounting. From the Home window choose the Setup 
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menu, then choose System Settings, and then Settings, then click 
the Dates.) 

Status bar text Most of the screens in Simply Accounting include a “status bar,” 
a line of text at the bottom of the screen. The line displays 
information about a field or menu item when you drag the 
mouse pointer over it. 

Online help You can display additional information or instructions for most 
tasks in Simply Accounting. Either press the F1 key, or use the 
Help button or Help menu to select a topic. 

Before You Start 
Install Simply 
Accounting 

Follow the installation instructions in the Simply Accounting 
Quick Start Guide. Select Typical if the program asks you what 
type of installation you prefer. 

Creating a Company 
You can create a company using one of the company templates 
that come with the program, modifying it to suit the needs of 
your business. In Exercise 1, you will create a company using the 
Service Company template. 

Exercise 1: Creating a Company 

This exercise outlines the steps to create a company from the 
Service Company template for Data Processing Services, a 
fictional company you will use in these exercises. 

You can use any Simply Accounting product (Basic, Pro, 
Premium, or Accountants’) to complete these exercises. The 
Workbook uses the Basic version of Simply Accounting for its 
examples. 
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 1. Start Simply Accounting. In Windows, on the Start menu, 
choose Programs (All Programs if you are using Windows 
XP), and choose Simply Accounting by Sage, and then 
Simply Accounting by Sage. 

 2. From the start-up screen, choose Create A New Company, 
and click OK. 

3. In the Setup Wizard window, click Next. 

4. Choose Custom Setup, then click Next. 

Professional Assistance 5. If you would like more information about professional 
assistance, click Find A Business Partner. If not, click Next. 

Type of Company 6. Select Copy A Template Containing Typical Accounts, and 
click Next. 

Choose the type of 
company and a 
company template 

7. Select (highlight) Service in the list of industries, and select 
Service Company in the list of company templates, then click 
Next. 

Business location 8. From the list of provinces, select British Columbia, then click 
Next. 

Company name and 
address 

9. Enter the following information: 

Name:  Data Processing Services 
Street 1: 2406 East Hastings St. 
City: Vancouver 
Province:  British Columbia             Code:  BC 
Postal:  V5K 1K1 
Country: Canada 
Phone 1:  (604) 555-1234 
Fax: (604) 555-6789 

Then click Next. 

File name 10. Change the location to store the company file to: 
C:\Program Files\Winsim\Samdata\, then click Next. 

Dates 11. Enter the following accounting information: 

Fiscal Year Start: 01-01-2015 
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Earliest Transaction: 01-01-2015 
Fiscal Year End: 12-31-2015 

Then click Next. 

Business type 12. Leave Sole Proprietor selected, then click Next. 

Business activities 13. Leave all the items checked, and click Next. 

Bank account 14. Uncheck (clear) Use The Same Bank Account, and click Next. 

Multi-currency 15. Under the question Do You Wish To Keep Track Of Foreign 
Currency Transactions, leave No selected, and click Next. 

Departmental 
Accounting  

16. If you use Simply Accounting Pro or higher, leave the Use 
Departmental Accounting box unchecked, and click Next. 

Capital assets 17. Check all the boxes (Vehicle, Building, and Land), and click 
Next. 

 18. Leave all the options checked on the Orders, Quotes, and 
Projects window, then click Next. 

Terminology 19. Leave Use Non-accounting Terms selected, and click Next. 

Business number 20. In the Business Number field, type 123456789RC0001, and 
click Next. 

Payroll Services 21. To learn about Payroll Services, click the Tell Me More 
button. To continue, click Next. 

Payroll definitions 22. Leave all the Income field names unchanged, and click Next. 

23. Change the deduction field names as follows: 

Deduction 1: Pension  
Deduction 2: Group Ins. (for Group Insurance) 
Deduction 3: Medical 
Deduction 4: Misc 1 
Deduction 5: Misc 2 

Then click Next. 

24. Leave the Additional Payroll window unchanged, and then 
click Next. 
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Project title 25. Enter or accept the following information: 

Project Title: Project 

Then click Next. 

Printer settings 26. In the Printer Settings window click Next. (Do not click the 
Printer Settings button. You will change the printer settings 
for reports and forms later, in Exercise 3.) 

Track Inventory 
Turnover 

27. Leave the Store Invoice Lookup Details box checked, and 
click Next. 

Cash-basis 
accounting 

28. Leave the Use Cash-Basis Accounting box unchecked, and 
click Next. 

Budgeting 29. Leave the Budget Revenue And Expense Accounts box 
unchecked, and click Next. 

Budget Project 30. Leave the Budget Projects box unchecked, then click Next. 

Account 
reconciliation  

31. Leave the Use Cheque No. As The Source Code For Cash 
Purchases And Sales box checked, and click Next. 

Sales taxes 32. Leave the Yes option selected, and click Next. This will 
automatically create a tax code that will calculate GST at a 
rate of 7.0% and PST at a rate of 7.0%.  

Payroll 33. Leave the Automatic Payroll Deductions box checked, and 
click Payroll Settings. 

Payroll settings – 
Income 

a) Under Income, you can see the different types of income 
you can pay your employees. For example, you can 
select whether an income is paid based on an hourly or 
differential rate. An hourly rate represents a base rate 
paid for standard work or hours, while a differential rate 
represents a rate beyond the standard or base rate. 

Income settings also show the taxes paid on various 
incomes as well as the EI, EHT and QHSF factors, and 
enable you to track Quebec tips. 

Leave all the information as shown, then click Payroll 
Deductions. 
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Payroll settings –
Deductions 

b) Under Deductions fill in the following information: 

 

Click OK to close the payroll Settings window. 

 34. Click Next. 

Forms 35. Enter 100 for all forms, and click Next. 

36. If the What’s Next window appears, click Next. 

Finish setup 37. Click Finish. You have now created a new company. Once 
Simply Accounting has finished opening the new company, 
the program opens the online help with a checklist of 
optional steps to complete your setup.  

Looking Up Company Information 
Simply Accounting stores background information about your 
company, such as your company’s name, address, business 
number, and the start and end dates of your fiscal year, for tax 
purposes. Once you begin using the program for day-to-day 
transactions, it updates your accounts and records in a file called 
“data file.” 

You can use the Company Information window to check your 
company information.  
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Exercise 2: Checking Your Company Information  

1. In the Home window from the Setup menu, choose System 
Settings, and then Company Information. 

2. Check that you correctly entered the company information 
during Exercise 1. 

The Company Information window should look like this: 

 

3. If you need to modify any of the information, type the 
correct information, and click OK to accept the changes. 
Otherwise, click Cancel to exit this window. 

Setting Up Reports and Forms 
Use the Reports And Forms window on the Setup menu to set 
options for printing reports, graphs, payroll and payment 
cheques, receipts, invoices, labels, purchase orders, sales orders 
or quotes, statements, and T4 and Relevé 1 slips. You must set 
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up at least one printer before you can print from Simply 
Accounting. 

The Report And Form Options window looks like this. If you are 
using Simply Accounting Pro or higher, you will also see Time 
Slips : 

 

Set up your printer for the report or form you plan to print. You 
can edit the following fields: 

Printer.  Click the arrow to the right of the field, and select a 
printer for the type of report you selected. Or, with the Printer 
field highlighted, press Alt+Down Arrow, use the arrow keys to 
highlight the printer you want, and then press Alt+Down Arrow 
again. 

Top Margin.  If a report is printing too high or too low on the 
page, enter an amount (in inches) by which you want the printed 
text to be lowered or raised. Positive amounts lower the text and 
negative amounts raise it. 

Left Margin.  Enter an amount (in inches) by which you want 
the printed text to be moved to the right or left if a report is 
printing too far to the left or right. Positive amounts move the 
print to the right and negative amounts move it to the left. 
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Form Type.  This box appears only if you choose Payroll 
Cheques, Payment Cheques, Sales Quotes, Statements, Receipts, 
Invoices, Purchase Orders, Deposit Slips, Direct Deposit Stubs, 
or Sales Order Confirmations. Use this box to choose a size to 
match the form you want to use. 

If you want to use customized forms, see “Customizing Forms 
and Management Reports,” in the Advanced Topics manual. (In 
the Home window select the Help menu, then choose Simply 
Accounting Manuals, and then Advanced Topics.)  

Form.  This box becomes active when you choose User-defined 
form in the Description field. The Form field shows the location 
of the file to use for the customized form. To use customized 
forms, see “Customizing Forms and Management Reports,” in 
the Advanced Topics manual. (In the Home window select the 
Help menu, then choose Simply Accounting Manuals, and then 
Advanced Topics.) 

Font and Size.  These options appear only under Labels, and the 
Payroll selections under Government Forms. Select a font and a 
type size from the lists. 

Show Subtotals In Invoice.  This option appears only under 
Invoices. Select this option to print the subtotal (before taxes) on 
invoices. 

Report Sections.  These options appear only under Reports. 
Select the font, type size, colour, and alignment you want to use 
in the report headers and footers. You can also select how you 
would like negative amounts to appear. 

■ Print System Date.  Prints today’s date on all reports to 
identify when the reports were generated.  

■ Show If Report Is Filtered.  Prints the words “This report 
has been filtered” on any report to which you apply a filter. 
For more information, see “Filtering Reports” in Chapter 1 
in the Advanced Topics manual. (In the Home window on the 
Help menu, choose Simply Accounting Manuals, then 
Advanced Topics.)  
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■ Show My Report Name.  Prints the name of the report 
template to the right of the report title, if the report was 
saved as a template. 

■ Check If Report Fits On Printed Page.  Checks if your 
report settings will cause the report to print across more 
than one page. 

E-Mail Form.  E-mail form options appear only if you choose 
Sales Quotes, Statements, Receipts, Invoices, Purchase Orders, or 
Sales Order Confirmations. Use this box to choose the form you 
want to use. 

If you want to use customized forms, see “Customizing Forms 
and Management Reports,” in the Advanced Topics manual. (In 
the Home window on the Help menu, choose Simply 
Accounting Manuals, then Advanced Topics.) 

Labels.  These fields appear only on the Labels tab: 

■ Label Height.  The minimum label height is one inch. 

■ Label Width.  The minimum label width is one inch. 

■ Number Of Labels Across The Page.  A maximum of nine 
labels can be printed across the page. 

Exercise 3: Entering Printer Options for Reports and Forms 

1. From the Setup menu, choose Reports And Forms. 

2. Under Reports, move through the fields, and enter or accept 
the following data: 

Printer: Choose a printer from the list. 
Top Margin: 1 
Left Margin: 1 
Report Sections: Leave the settings. 

3. Click OK to accept these settings. 
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Settings 
Simply Accounting options are divided into two categories — 
user and system options. If you set up Simply Accounting so 
that you need a user name and password to open a company, 
each user can customize their user settings. Changes to system 
settings affect all users. 

User Settings 

User settings allow you to change settings related to the way you 
interact with Simply Accounting. 

The User Preferences window looks like this: 

 

Terminology.  If you are not familiar with accounting terms, 
select non-accounting terminology. 

Microsoft Excel Language.  Choose the language you use 
when working in Microsoft Excel. 

Open Records and Transaction Windows With.  Select 
whether you want to click once or twice to open records and 
transaction windows from the Home window. 
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Automatically Save Changes to Vendor, Customer, and 
Other Records.  If you select this option, changes are 
automatically saved when you close a record. If you want 
Simply Accounting to ask you whether you want to save 
changes, turn off this option. 

 List button Show List Buttons Throughout Simply Accounting for Easier 
Data Entry.  If you select this option, the program displays List 
buttons at certain fields in Simply Accounting windows. When 
you click a List button, a list of options for that field will appear. 

Simply Accounting 
Pro or higher 

Automatically Refresh Lists.  If you enter transactions while 
running Simply Accounting in multi-user mode, check this box if 
you want the program to automatically update lists of records. 

Show a List of Inventory Items When An Unknown Inventory 
Item Number Is Entered.  Choose this option if you want the 
program to provide a list of all inventory items and services if an 
item number is entered incorrectly. With this option selected, 
when you type the first letter or number of an item on an order 
or invoice, a new window pops up allowing you to search for 
the specific item by number or description. 

Always Apply Allocation to Complete Transaction.  Check 
this box if you want Simply Accounting to automatically allocate 
all items in a transaction in the same way (this option can be 
changed on each transaction record). 

System Settings 

The Settings window for system settings allows you to set 
options such as interest charges, payroll taxes, aging periods, 
and the format and contents of invoices and reports. 

The Settings window looks like this: 
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System options Use Cash-Basis Accounting.  Select this option if you want to 
use cash-basis accounting. Leave it turned off if you want to use 
accrual-basis accounting. 

Store Invoice Lookup Details.  Select this option to have the 
program store all invoice details so you can look them up later. 
This feature uses extra space on your hard disk, but provides 
useful information. 

Use Cheque Number as the Source Code for Cash 
Purchases and Sales.  If you use the account reconciliation 
feature, select this option to use the cheque number, rather than 
the invoice number, as the source document number (for lookup 
purposes) in the Reconciliation and Deposits window for 
purchases and sales paid by cheque. 

Do Not Allow Transactions Dated Before.  Use this option to 
avoid processing transactions in an earlier period. 

Allow Transactions in the Future.  Select this option to be able 
to process transactions with dates up to the end of the current 
fiscal year. Leave it turned off to allow transactions up to and 
including the session date. 

Warn If Transactions Are [     ] Days in the Future.  If you 
allow transactions in the future, select this option to receive a 
warning if you try to enter a transaction date a certain number of 
days beyond the session date. 
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Warn If Accounts Are Not Balanced When Entering A New 
Month.  Select this option to receive a reminder if your accounts 
are not balanced whenever you advance the session date into a 
new month. 

Display A Backup Reminder When Session Date Changes.  
Check this box to be reminded to back up your company data 
every time you change the session date. 

Display A Backup Reminder When Closing This Company.  
Check this box to be reminded to back up your company data 
every time you close Simply Accounting. 

Exercise 4: Entering Settings 

You have already entered several settings using the Setup 
wizard during Exercise 1. In Exercise 4, you will use the Settings 
windows to enter more settings and to check that you entered 
the correct information during Exercise 1. 

1. In the Home window from the Setup menu, choose User 
Preferences, and then the Options tab. 

Enter user settings 2. Enter or accept the following settings: 

Terminology: Use Non-accounting 
Terms 

In the Home Window Open Record 
and Transaction Windows With: Single Click 

Automatically Save Changes To  
Vendor, Customer and Other  
Records: Yes 

Show List Buttons Throughout  
Simply Accounting For Easier  
Data Entry: Yes 

Show A List of Inventory Items  
When An Unknown Inventory  
Item Number Is Entered: Yes 

Always Apply Allocation To  
Entire Transactions: No 

3. Click OK. 
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4. In the Home window from the Setup menu, choose System 
Settings, and then Settings. 

Enter company 
settings 

5. Under Company, choose System. Note the following 
information that you entered during Exercise 1: 

Use Cash-Basis Accounting: No 
Store Invoice Lookup Details: Yes 
Use Cheque Number As  
 The Source Code For Cash  
 Purchases And Sales: Yes 

Enter or accept the following settings:  

Cash Accounting Date: Leave blank 
Allow Transactions In The Future: No 
Days In The Future: Leave blank 
Warn If Accounts Are Not Balanced 
 When Entering A New Month: Yes 
Display A Backup Reminder When  

Session Date Changes: Daily 
Display A Backup Reminder When  

Closing This Company: Yes 

6. Under Company, choose Features, and then check the My 
Company Uses Project box. 

Enter forms settings 7. Under Company, choose Forms, and then enter or accept the 
following settings (note that you have already entered 100 in 
the Next Form Number fields during Exercise 1).  
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8. Under Company, choose E-mail, and then select Invoices. In 
the Message box, type this message:  

Please open the attachment using your word processor. 
The attachment may not display correctly, but you 
should be able to print it. If you are unable to print it, 
call us immediately. 

Select PDF in the Attachment Format For Forms box. 

Repeat this message for the remaining e-mail forms, except 
for purchase quote and purchase invoice confirmations. 

Tip:  Instead of retyping the message each time, you can 
select (highlight) and copy (Ctrl+C) the first message, then 
paste it (Ctrl+V) in the Message boxes of the other forms. 

Enter vendors and 
purchases settings 

9. Under Vendors And Purchases, choose Options, and enter 
the following settings: 

Aging Periods: 30  45  60 
Calculate Discounts Before Tax 
 For One-Time Vendors: No 

Enter customers and 
sales settings 

10. Under Customers And Sales, choose Options, and enter or 
accept the following settings: 

Aging Periods:  30  45  60 
Interest Charges: Yes (1%, 60 Days) 
Include Invoices Paid In The  
 Last [     ] Days On Statements:  31 
Early Payment Terms: 1%, 10 Days 
  Net 30 Days 
Calculate Discounts Before Tax: No 
Tax Code for New Customers G - GST 7% 
Print Salesperson On Invoices,  
 Orders, Quotes No 

The window should look like this:  
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Enter inventory and 
services settings 

11. Under Inventory And Services, choose Options, and then 
enter or accept the following settings: 

Profit-Evaluation Method: Margin 
Sort Inventory And Services By: Number 
Allow Inventory Levels To Go 
 Below Zero: Yes 

Enter project settings 12. Under Project, choose Allocation, and then enter or accept 
the following settings: 

Allocate Payroll Transactions By:  Amount 
Allocate Other Transactions By: Amount 
Warn If Allocation Is Not Complete: No 
Allow Access To Allocate Field  

Using Tab Key: No 

13. Under Project, choose Budget, and leave the Budget Project 
box blank. 

14. Under Customers And Sales, choose Comments and enter 
the following comments: 

Sales Invoices: Watch for our spring sale. 
Sales Order Confirmations: Thank you for your order! 
Sales Quotes: Order within 10 days to qualify 

for this special rate. 

15. Click OK to accept the settings. 
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Adapting the Chart of Accounts 
The Service Company template you copied earlier included a list 
of accounts called the chart of accounts. You will now adapt the 
chart of accounts to suit the needs of Data Processing Services. 

To set up a chart of accounts that reflects your needs, you change 
the names and numbers of existing accounts, and add new 
accounts. When numbering your new accounts, you must assign 
numbers within the following ranges: 

Assets 1000 to 1999 
Liabilities 2000 to 2999 
Equity 3000 to 3999 
Revenues 4000 to 4999 
Expenses 5000 to 5999 

Note:  In Simply Accounting Premium or higher, you can set up 
an extended numbering system. See Chapter 2 “Setting Up 
Accounts” in the User Guide. 

The program prints accounts on the balance sheet and income 
statement in numerical order. 

To adapt the chart of accounts, you open the Accounts window 
in the General Module. Then, to modify an existing account or 
create a new account, you enter information in the following 
fields: 

Account.  Enter the account number in the first part of the field 
and the account name in the second part. 

Inactive Account.  Check this box to set the account status to 
Inactive. Inactive accounts are not listed in transaction windows, 
and you can choose to omit them on most reports. 

On the Account tab Account Type.  Select one of five account types. For an 
explanation of account types, see “Account Types,” in Chapter 2 
in the User Guide.  

GIFI Code.  Enter a GIFI code for the account if you file your 
corporate financial statements electronically. (Contact the 
Canada Revenue Agency or your accountant for information on 
GIFI codes.) 
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Omit From Financial Statements If Balance Is Zero.  Check 
the box to omit the account from financial statements if its 
balance is zero. Leave the box unchecked if you want the 
account to appear on financial statements, regardless of its 
balance. 

Allow Project Allocations.  Check this box to be able to allocate 
amounts to projects. 

Opening Balance.  Enter the account balance as of the earliest 
transaction date. 

On the Class Options 
tab 

Account Class.  Select a description of the account’s purpose. 
Assigning account classes for asset accounts is particularly 
useful, because you can differentiate between cash, bank, and 
other types of asset accounts. 

On the Reconciliation 
and Deposits tab 

Save Transactions For Account Reconciliation.  Check this 
box if the account is a bank or credit-card account, and you want 
to reconcile the transactions in this account to the transactions on 
your bank or merchant statement. 

On the Additional 
Information tab 

Fields 1 to 5.  Enter additional information about this account if 
you wish. You can rename each of the five fields by choosing Set 
Field Names from the File menu.  

Exercise 5: Modifying Existing Accounts 

 

 Accounts 

1. In the Home window open the Accounts window (choose 
the Accounts icon). 

2. In the Accounts window, scroll to account 1520 Category A, 
and double-click it to open the account. 

3. In the Account description field, type Computer Supplies. 

The screen should look like this: 
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You can type a new account 
description in this box. 

Scroll through the chart 
of accounts using these 
buttons. 

 

4. Use the arrow buttons to scroll through the list of accounts. 
Select the following accounts and make these changes (after 
you change each account, if asked if you want to save your 
changes, click Yes): 

Change this: To this: 

1530 Category B Manuals 

1540 Category C Computer Hardware 

4020 Sales Inventory A Sales -- Computer Supplies 

4030 Sales Inventory B Sales -- Manuals 

4040 Sales Inventory C Sales -- Computer Hardware

5020 Category A Cost -- Computer Supplies 

5030 Category B Cost -- Manuals 

5040 Category C Cost -- Computer Hardware

5. Open account 2240 Deduction 1 Payable. 

6. In the Account description field, type Pension Payable. 
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 7. Change the Account Type to Subgroup Account. 

8. Change these account descriptions and types: 

Change this: To this: 

2250 Deduction 2 Payable Group Ins. Payable 
Subgroup account 

2260 Deduction 3 Payable Medical Payable 
Subgroup account 

2270 Deduction 4 Payable Subgroup account 

2280 Deduction 5 Payable Subgroup account  

 

9. Close the Account record by clicking the “x” in the top-
right corner of the record window, or press Alt+F4. 

10. To close the Accounts window, double-click the small icon 
in the upper-left corner of the window, or press 
Alt+Spacebar, then choose Close. The changes you have 
just made to the accounts are saved automatically. 

Exercise 6: Adding Accounts 

1. In the Home window, choose the Accounts icon. 

2. Using the scroll bar on the right, scroll in the Accounts icon 
window until you see Account 2300 PST Payable. Select 
(highlight) it. 

 
Create 3. From the File menu or toolbar, choose Create. Enter the 

following information: 

Account Number: 2290 
Account Description: Deductions: Total 
Account Type: Subgroup Total 

The screen should look like this: 



Adapting the Chart of Accounts 

22    Simply Accounting 

 

SIM2005 CDN WB - PRINT.doc, printed on 10/12/2005, at 8:18:44 AM. Last saved on 
10/12/2005 8:15:00 AM. 

ACCPAC INTERNATIONAL, INC. Confidential 

 

Select Subgroup Total as the 
account type. 

Enter the number and 
description. 

 

4. Click the Create Another button. 

5. Add another account, entering this data: 

Account: 4410 
Account Description:  Shipping and Handling Revenue 
Account Type: Group Account 

 
Save 6. From the File menu or the toolbar, choose Save and then 

close the record, or click the Save and Close button. 

 
Display By 
Type 

7. In the Accounts icon window, with Display By Type selected 
in the toolbar, check that you have correctly modified and 
added the accounts as instructed in the preceding exercises. 

 
Check The 
Validity Of 
Accounts 

8. From the File menu or the toolbar, choose Check The 
Validity Of Accounts to check the organization of your chart 
of accounts. If you have made an error when modifying your 
chart of accounts, the program displays a message 
describing the problem. Check the accounts you have added, 
and make any needed corrections. 
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Linked Accounts 
When you enter transactions, such as sales, purchases, and 
payments, Simply Accounting keeps track of all the amounts for 
you in the Accounts window. Some of the accounts in the 
Accounts list are linked to the windows in which you enter 
transactions and to the records for inventory that you track in 
Simply Accounting. Linking ensures that the program updates 
all related records automatically when you process a transaction. 

To see which linked accounts are included in your company 
setup, from the Home window, choose Setup, then System 
Settings, and then Linked Accounts. Choose the following 
modules: 

■ General 

■ Vendors and Purchases 

■ Customers and Sales 

■ Payroll 

■ Inventory Items 

Exercise 7: Deleting Linked Accounts 

You may want to delete the linked accounts you never use. 
Deleting linked accounts requires two steps: removing the link, 
and removing the account. In this two-part exercise, you will 
delete a linked account. 

Part 1: Unlinking an Account 

1. From the Setup menu, choose System Settings, then Linked 
Accounts, and then Inventory And Services. 

2. Select 5120 Item Assembly Costs, and press the Delete key 
on your keyboard to remove the link. 

The window should look like this: 
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3. Click OK to accept the changes. The account is no longer 
linked, but it still exists in the Accounts list. Follow the steps 
in the next section to remove the account. 

Part 2: Removing the Account from the Chart of Accounts 

1. Open the Accounts window. 

 
Remove 2. Highlight account 5120 Item Assembly Costs, and click the 

Remove button, or choose Remove from the File menu. 

3. Click Yes to confirm the removal of the account. 

 
Check The 
Validity Of 
Accounts 

4. From the File menu or the toolbar, choose Check The 
Validity Of Accounts to ensure that your chart of accounts is 
logically organized. 

5. Close the Accounts window. The changes you have just 
made are saved automatically; the account has been 
removed. 

Exercise 8: Linking New Accounts 

Linking a new account requires two steps: creating the account 
in the Accounts window, and linking it. In this two-part exercise, 
you will add a linked account. 
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Part 1: Create a New Account 

1. Open the Accounts window. 

2. Scroll to account 1070 Total Cash, and select (highlight) that 
account. 

 
Create 3. Click the Create button on the toolbar, and enter the 

following record: 

 

4. Click the Class Options tab. 

5. In the Account Class field, select Bank. 

6. In the Next Cheque No. field, type 100. 

7. Click the Save and Close button, or choose Save from the 
File menu, and close the account record. 

8. Close the Accounts icon window. 

Part 2: Link the Account 

1. In the Home window from the Setup menu, choose System 
Settings, then Linked Accounts, and then Customers And 
Sales. 
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2. Link the new account by clicking on the arrow to the right of 
the Principal Bank Account field, then clicking on 
1069 Central Bank: Richmond. Or, press Alt+Down Arrow to 
display the list of accounts, use the Up or Down Arrow key 
to reach the account, then press Alt+Down Arrow to select 
it.  

 

3. Click OK to accept the entry. 

 
Display Chart 
of Accounts 

4. To review the changes to your account list, in the Home 
window, choose Reports, then Lists, and then Chart of 
Accounts. 

Adding Vendors 
The Vendors window contains records of all the vendors 
(suppliers) with whom your company does business. Each 
record contains tabs on which you enter information about a 
vendor. 
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Address tab 

 

On the Address tab, you enter information in these fields: 

Vendor.  Enter the vendor’s name. The program does not allow 
you to enter identical vendor names. 

Contact.  Enter a contact name, usually the person you deal 
with most often when you write, phone, or e-mail the vendor. 

Street 1 and Street 2.  Enter the vendor’s street address. 

City, Province, and Country.  Enter the vendor’s city, province, 
and country. The names you entered for your company in the 
Company Information window are displayed automatically. 

Postal Code, Phone 1, Phone 2, and Fax.  Enter the vendor’s 
postal code, phone, and fax numbers. 

Tax ID.  Enter the vendor’s business number or social insurance 
number. 

E-Mail and Web Site.  Enter the vendor’s e-mail address and 
Internet URL (Web site address). 

Department.  If you are using Simply Accounting Pro or higher 
and have checked Use Departmental Accounting in the System 
Settings, you can assign the transactions associated with this 
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vendor to a specific department in your company. For more 
information on departments, see the User Guide. 

Inactive Vendor.  Check this box if you no longer interact with 
this vendor but want to keep the record for reference. 

Payroll Authority.  Check this box to identify vendors to whom 
you remit payments for tax and other payroll liabilities.  

Options On the Options tab, you enter information in these fields: 

Expense Account.  Enter the expense account that you 
normally use to record the non-inventory purchases from this 
vendor (that is, purchases for which you have not created an 
inventory record). The account number you enter in the Expense 
Account field will automatically appear in the Account field of 
the first line in the detail section of the Purchases, Orders and 
Quotes window. 

Early Payment Terms.  Enter the payment terms the supplier 
generally offers you. Payment terms include an early-payment 
discount rate (a percentage), a period (in days), and the number 
of days until the invoice is due in full. 

For example, if an invoice from your supplier has terms of 1%, 
10 days, net 30, you would receive a 1-percent discount for 
paying in full within 10 days of the invoice date. You can also 
pay as late as 30 days from the invoice date, but you will lose the 
discount. 

Calculate Discounts Before Tax.  If the vendor calculates the 
early-payment discount on the full invoice amount, including 
tax, then leave this box unchecked. If the discount applies only 
to the amount before tax, then check the box. 

Include This Vendor When Printing T5018 Slips.  Select this 
option if you wish to include the vendor when printing T5018 
(Statement of Contract Payments) slips. 

Print Contact On Cheques.  Check this box if you want the 
program to print the contents of the Contact field on your 
payment cheques to vendors. You would leave it unchecked if 
the Contact field contains the name of the person you normally 
phone, e-mail, or write to at the vendor’s company. 
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[     ] Purchase Orders For This Vendor.  Select Print if you 
normally print purchase orders for this vendor, or E-mail if you 
normally send purchase orders via e-mail. 

E-Mail Confirmation Of Purchase Invoices And Quotes.  If 
you include an e-mail address in the E-mail field on the Address 
tab, you can send confirmation by e-mail to the vendor 
automatically when you process an invoice or quote. Check this 
box if you want Simply Accounting to send confirmation of 
receipt of this vendor’s invoices and quotes automatically. 

Taxes On the Taxes tab, you enter information in these fields: 

Tax.  This column lists all the taxes that you have set up for this 
company; it does not represent the taxes assigned to the tax code 
described later. You cannot edit this field. 

Tax Exempt.  This column specifies whether purchases from 
this vendor are exempt from the selected tax. Click this field to 
set to Yes or No as follows: 

■ If purchases are tax-exempt (that is, the tax is not to be 
charged on purchases), set to Yes.  

■ If purchases are not tax-exempt (that is, the tax is to be 
charged on purchases), set to No. 

Tax Code.  Select the tax code that you normally use for this 
vendor. When you enter an item on a purchase invoice, order or 
quote for this vendor, Simply Accounting will automatically 
charge the taxes defined by the tax code. However, you can 
exclude some or all of the taxes by editing the Tax Exempt 
column, described earlier. 

Statistics Complete the following fields on the Statistics tab: 

Year-to-Date Purchases, Last Year’s Purchases.  Enter this 
information, if available. 

Payments for 2015, Payments for 2014.  Note that the fields 
for Payments For 2015 and Payments For 2015 refer to the 
current year and the previous year, respectively. Enter these 
amounts manually if you need to include payments to this 
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vendor that were not made using Simply Accounting. Normally, 
you do not need to enter these amounts manually. 

Recalculate.  You can replace an amount you entered for the 
year by clicking the Recalculate button. Simply Accounting 
totals the payments recorded for the vendor. 

Reminders You can record and recall important information about the 
vendor on the Memo tab. The Memo tab looks like this: 

 

 

Simply Accounting can 
remind you to take 
action with respect to 
this vendor, if you 
complete these fields. 

 

Import and export 
purchase 
transactions 

You can import purchase invoices and quotes that your vendor 
sends you by e-mail, if both you and the vendor use Simply 
Accounting version 7.0 or higher and have MAPI-compatible 

e-mail programs, such as Microsoft® Outlook® Express or 

QUALCOMM® Eudora. You can also e-mail purchase orders to 
your vendor that they can import into their Simply Accounting 
program. 

This Vendor Has Simply Accounting And Can Import Orders.  
Check this box if you wish to be able to import invoices and 
quotes from, and export purchase orders to this vendor. 

This Vendor Uses My Item Numbers On Invoices And 
Quotes.  If the vendor uses the same numbers as you do for 
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inventory items and services, check this box. You do not have to 
match the vendor’s item and service numbers with yours. 

However, if the vendor uses different numbers for items and 
services, match each of your vendor’s item numbers with your 
item number or an inventory or services account in the table 
below. 

To find out more about importing transactions, see the Advanced 
Topics manual. (In the Home window on the Help menu, choose 
Simply Accounting Manuals, then Advanced Topics.) 

Additional 
information  

Fields 1 to 5.  On the Additional Information tab, enter 
additional information about this vendor if you wish. You can 
rename each of the five fields by choosing Set Field Names from 
the Edit menu. 

Historical transactions You can enter historical invoices and payments on this tab after 
you create the vendor record. You will add history in a later 
exercise. 

Exercise 9: Adding Vendor Records 

 
Vendors 

1. In the Home window, choose the Vendors icon. 

2. From the File menu or the toolbar, choose Create. 

3. On the Address tab, enter the following vendor 
information: 

Vendor: Data International Corp. 
Contact: John Crowley 
Street 1: 2 Dowding Rd. 
City: Vancouver 
Province: British Columbia 
Postal Code: V6X 2P9 
Country: Canada 
Phone 1: (604) 555-2552 
Fax: (604) 555-2553 
Tax ID: 011-234-567 
E-mail: crow@smile.com 
Web Site: http://whiz.datacorp.net 
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The Address tab should look like this: 

You can click this 
button to visit the 
vendor’s Web site, if 
you include a URL in 
the Web Site field. 

You can click this 
button to send an 
e-mail message to the 
vendor, if you include 
an address in the 
E-Mail field. 

 

4. Click the Options tab, and enter the following information: 

Expense Account: Leave blank 
Early Payment Terms: 1.25%, 21 Days, Net 60 
Calculate Discounts Before Tax: No 
Include This Vendor When 
 Printing T5018 Slips: No 
Print Contact On Cheques: No 
E-Mail Confirmation Of Purchase 
 Invoices And Quotes: No 
 [     ] Purchase Orders For This  
 Vendor: Print 

The Options tab should look like this: 
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5. Click the Taxes tab, and in the Tax Code field, select GP 
(which specifies a GST of 7% and PST of 7.0%). 

 

6. Click the Statistics tab, and enter the following information: 

Year-to-Date Purchases: 125.25 
Last Year’s Purchases: 563.45 
Payments for 2015: 0.00 
Payments for 2014: 0.00 

7. Click Create Another to add the vendor to your records. 

8. Repeat steps 3 to 7, entering these two vendors: 

On the Address tab Vendor: Hart Computer Software Unlimited 
  Supplies  
Contact: Elizabeth Hart Walter Quan 
Street 1: 1047 Cornell Ave. 3491 West 41 St. 
City: Victoria Vancouver 
Province: British Columbia British Columbia 
Postal Code: V3R 1M7 V2B 7Z8 
Country: Canada Canada 
Phone 1: 250 555 1962 604 555 2098 
Fax: 250 555 3625 604 555 2943 
Tax ID: 012-234-567 013-234-567 
E-mail: ehart@lilt.com quan@telly.com 
Web Site: leave blank leave blank 
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On the Options tab Expense Account: blank blank 
Include This Vendor 
 When Printing 
 T5018 Slips: No No 
Print Contact 
 on Cheques: No No 
E-Mail Confirmation  
 Of Purchase  
 Invoices And 
 Quotes: No No 
 [     ] Purchase  
 Orders For 
 This Vendor: Print Print 

On the Taxes tab Tax Code:  GP GP 

On the Statistics tab YTD Purchases:  126.32 125.74 
Last Year’s 
 Purchases: 335.75 180.60 
Payments for 2015: 0.00 0.00 
Payments for 2014: 0.00 0.00 

9. Close the Vendor Records window. 

10. In the Vendors icon window, from the Reports menu, choose 
Display Vendor List. Select all fields and then click OK to 
review the information you just entered. 

Adding Customers 
The Customers window contains records of all the customers 
with whom your company does business. Each record contains 
tabs on which you enter information about a customer. 

Addresses The Address tab in a customer’s record looks like this: 
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You enter information in these fields: 

Customer.  Enter the customer’s name. The program does not 
allow you to enter identical customer names. 

Contact.  Enter a contact name, usually the person you deal 
with most often when you write, e-mail, or phone the customer. 

Street 1 and Street 2.  Enter the customer’s street address.  

City, Province, and Country.  Enter the customer’s city, 
province, and country. The names you entered for your 
company in the Company Information window are displayed 
automatically. 

Postal Code, Phone 1, Phone 2, and Fax.  Enter the 
customer’s postal code, phone, and fax numbers. 

E-Mail and Web Site.  Enter the customer’s e-mail address and 
Internet URL (Web site address). 

Department.  If you are using Simply Accounting Pro or higher 
and have checked the Use Departmental Accounting in the 
System Settings, you can assign the transactions associated with 
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this customer to a specific department in your company. For 
more information on departments, see the User Guide. 

Inactive Customer.  Check this box if you no longer interact 
with this customer but want to keep the record for reference. 

Internal Customer.  This box appears in Simply Accounting Pro 
and higher. Check this box if the customer is to be included in 
Time and Billing to track activities performed for a department 
within the company, but not included in the customer list used 
for sales invoices, orders or quotes.  

Shipping address If you ship goods to a customer at an address different from the 
mailing address (where you send invoices), record shipping 
details on the Ship-To Address tab. Otherwise, check the Same 
As Mailing Address box. This address appears on sales invoices, 
orders, and quotes beside the mailing address. 

Options You enter credit terms and other housekeeping information 
regarding the customer on the Options tab. 

Revenue Account.  Enter the revenue account that you 
normally use to record the non-inventory sales to this customer 
(that is, sales for which you have not created an inventory 
record). The account number you enter in the Revenue Account 
field will automatically appear in the Account field of the first 
line in the detail section of the Sales, Orders and Quotes 
window. 

Price List.  Select the price list you want to use for this customer, 
regular or preferred. If you are using Simply Accounting Pro or 
higher, you may set up additional price lists to assign your 
customers. 

Early Payment Terms.  Enter the payment terms you generally 
offer this customer. Payment terms include your early-payment 
discount rate (a percentage), a period (in days), and the number 
of days until an invoice is due in full. The program automatically 
displays the terms you entered on the Customers and Sales tab 
in the Settings window (under System Settings on the Setup 
menu), but you can change the terms for individual customers if 
you wish.  
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Produce Statements For This Customer.  Check this box if you 
want to create statements for this customer. 

[     ] Forms For This Customer.  Select Print if you normally 
print invoices or order-confirmation forms for this customer, or 
E-mail if you normally send them via e-mail. 

Taxes Use the Taxes tab to record tax information for this 
customer.  

Tax.  This column lists all the taxes that you have set up for this 
company; it does not represent the taxes assigned to the tax code 
described later. You cannot edit this field. 

Tax Exempt.  This column specifies whether sales to this 
customer are exempt from the selected tax. Click this field to set 
to Yes or No as follows: 

■ If sales are tax-exempt (that is, the tax is not to be charged on 
sales to this customer), set to Yes.  

■ If sales are not tax-exempt (that is, the tax is to be charged on 
sales to this customer), set to No. 

Tax ID.  This is the customer’s government-assigned tax ID 
number for the selected tax. 

Tax Code.  Enter the tax code that normally applies to this 
customer. When you enter an item on an invoice, sales order or 
quote for this customer, Simply Accounting will automatically 
charge the taxes defined by the tax code. However, you can 
exclude some or all of the taxes by editing the Tax Exempt 
column, described previously. 

Note:  You can assign a default tax code to use for new 
customers. In the Home window select the Setup menu, then 
choose System Settings, and then Settings. Under Customers and 
Sales, choose Options and select a code from the Tax Code for 
New Customers field. 
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Statistics Use the Statistics tab to keep track of your sales to this 
customer. 

Year-To-Date Sales and Last Year’s Sales.  Enter this 
information, if available. 

Credit Limit.  Enter an amount, if applicable. The program 
warns you before you process a sale that will exceed this limit. 
(You can still process invoices that exceed the credit limit.) 

Memo You can record and recall important information about the 
customer on the Memo tab.  

Import and export 
sales transactions 

To be able to import and export sales transactions, complete 
the information on the Import/Export tab. The 
Import/Export tab looks like this: 

 

If you and your customer both have Simply Accounting 
version 7.0 or higher and MAPI-compatible e-mail programs, 
such as Microsoft Outlook Express or QUALCOMM Eudora, 
you can e-mail sales invoices and quotes that they can import 
into their Simply Accounting program. You can also import sales 
orders that your customers e-mail to you as purchase orders. 

This Customer Has Simply Accounting And Can Import 
Invoices And Quotes.  Check this box if you want to be able to 
e-mail sales transactions that this customer can import directly 
into their Simply Accounting program. 

This Customer Uses My Item Numbers On Orders.  If the 
customer uses the same numbers for inventory items and 
services that you do, check this box. You do not have to match 
their item and service numbers with yours.  
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However, if they do not use the same numbers that you do, 
match each of your customer’s item numbers with your item 
number or an inventory or services account in the table below. 

To find out more about importing transactions, see the Advanced 
Topics manual. (In the Home window on the Help menu, choose 
Simply Accounting Manuals, then Advanced Topics.) 

Additional 
Information 

Fields 1 to 5.  Enter additional information about this customer 
if you wish. You can rename each of the five fields by choosing 
Set Field Names from the File menu. 

 
Historical transactions You can enter historical invoices and payments on this tab after 

you create the customer record. You will add history in a later 
exercise. 

Exercise 10: Entering Customer Records 

 
Customers 

1. In the Home window, choose the Customers icon. 

2. From the File menu or the toolbar, choose Create. 

3. Move from field to field, entering the following 
information on the address tab: 

Customer: Software Corp. 
Contact: Leo da Costa 
Street 1: 921 Vulcan Street 
City: Vancouver 
Province: British Columbia 
Postal Code: V1W 1E5 
Country: Canada 
Phone 1: (604) 555 5921 
Fax: (604) 555 5217 

4. On the Ship-To Address tab, enter the following 
information: 

Contact: Mario DiFranco 
Street 1: 23 Pemberton Ave. 
Street 2: Suite 221 
City: Richmond 
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Province: British Columbia 
Postal Code: V6V 2X7 
Country: Canada 

5. On the Options tab, enter the following information: 

Revenue Account: Blank  
Price List: Regular 
Early PaymentTerms: Accept the amounts 
Produce Statements for this 
 Customer: Yes 
[     ] Forms For This Customer: Print 

6. On the Taxes tab, enter the following so that the customer 
will be automatically assigned the tax code GP (GST and 
PST) when you enter sales orders or invoices: 

GST Tax Exempt: No 
PST Tax Exempt: No 
Tax Code: GP (GST 7%, PST 7.0%) 

 

7. On the Statistics tab, enter the following information: 

Year-To-Date Sales: 122.15 
Last Year’s Sales: 574.75 
Credit Limit: 6,000.00 

Note:  For the credit limit, you can type 6000. Simply 
Accounting automatically formats the number. 

8. Click Create Another to add the customer to your records. 

9. Repeat steps 3 through 8, entering the following records: 

On the Address tab Customer: Management Action Line 
  Consulting 
Contact: Sally Kesterton Steven Wong 
Street 1: 4215 Georgia Street 389 W. 49 Ave. 
City: Vancouver Burnaby 
Province: British Columbia British Columbia 
Postal Code: V3W 9S9 V8Y 1U7 
Country: Canada Canada 
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Phone 1: (604) 555 4782 (604) 555 3385 
Fax: (604) 555 1847 (604) 555 3386 

On the Ship-To 
Address tab 

Same As  
 Mailing Address:  Yes Yes  

On the Options tab Revenue Account:   Blank                          Blank 
Price List:                  Regular                      Preferred  
Early Payment 

Terms:  0%, 0 Days, Net 30 Accept 
Produce 
 Statements: Yes Yes 
[     ] Forms For  
 Customer: Print Print 

On the Taxes tab GST Tax Exempt:  No No  
PST Tax Exempt: No No 
Tax Code: GP GP 

On the Statistics tab Year-To-Date Sales: 124.15 0.00 
Last Year’s Sales: 4,000.00 2,000.00 
Credit Limit: 2,000.00 3,000.00 

10. Close the customer’s record, but leave the Customers icon 
window open. 

11. From the Report menu, choose Display Customer List.  

12. To review the information you just entered, choose Select All 
and click OK. 

13. Close the window. 

Adding Employees 
The Employees window contains records for all your company’s 
employees. Each record contains several tabs on which you enter 
information about an employee. 

Personal tab The Personal tab looks like this: 
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On this tab, enter the employee’s personal information, such as: 

Hire Date.  Enter the date the employee was hired.  

Terminate.  If the employee no longer works for your company, 
enter the employee’s termination date. 

ROE Code.  Enter the code that describes the employee’s reason 
for leaving the company. This code prints on the employee’s 
ROE (Record of Employment) form. 

Department.  If you are using Simply Accounting Pro or higher 
and have checked Use Departmental Accounting in the System 
Settings, you can assign the transactions associated with this 
employee to a specific department in your company. For more 
information on departments, see the User Guide. 

Date Last Paid.  This field will display the date the employee 
was last paid, once you have entered a paycheque. 

Inactive Employee.  Select Inactive if the employee has left 
your company or is on unpaid leave. 
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Language Preference.  Select the language to use for forms 
and cheques issued to this employee. 

Job Category.  Job categories can help you save time when 
entering invoices and time slips. If you want to use Job 
Categories, set them up using the Setup Menu in the Home 
window (select System Settings and then Job Categories). 

Taxes tab Enter information about federal and provincial taxes on the 
Taxes tab. 

Tax Table.  Display the list of provinces, then select the one in 
which the employee resides. 

Federal Claim.  Enter the total claim amount shown on the 
employee’s federal TD1 form. This is a dollar amount, not a 
claim code. 

Federal Claim Subject to Indexing.  Enter the employee’s 
federal tax credit amount that is eligible for indexation. 

Provincial Claim.  Enter the amount of the employee’s 
provincial tax credit. This is a dollar amount, not a claim code. 

Provincial Claim Subject to Indexing.  Enter the employee’s 
provincial tax credit amount that is eligible for indexation. 

Deduct EI.  If the employee is EI insurable, check the Deduct EI 
box, then enter the employer’s EI premium rate. The EI factor 
entered on the Payroll tab in the Settings window is displayed 
automatically, but you can change it. The field accepts four 
decimal places. If the employee is not EI insurable, leave the 
Deduct EI box unchecked. 

Deduct CPP/QPP.  Check this box if Canada/Quebec Pension 
Plan premiums should be deducted from the employee's 
paycheque. Remove the check from this field if the employee is 
exempt from paying CPP or QPP premiums for reasons other 
than age. 

Enter additional 
income tax 

Additional Federal Tax.  If you wish, enter an additional 
amount of federal income tax to be deducted from the 
employee’s pay every pay period. 
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The program uses the amount you enter in this field, plus the 
amount it calculates using the current tax rate, to find the total 
amount of income tax to deduct from the employee’s pay for the 
pay period. 

Income tab Enter salary and wages information on the Income tab. 

Note:  To specify the taxes that apply to each type of 
income, open the Setup menu, choose System Settings and 
then Settings; then click the Payroll tab and check or clear 
(uncheck) the boxes for each income type. 

Benefits.  If you pay benefits to or make contributions on behalf 
of the employee in addition to the regular salary, enter the 
amount in this field. 

Quebec Benefits.  If you pay benefits to or make contributions 
on behalf of a Quebec employee in addition to the regular salary, 
enter the amount in this field. 

Regular, Overtime 1, and Overtime 2.  If the employee is paid 
by the hour, enter the dollar amount per hour for regular pay 
and up to two different rates for overtime pay. You can enter up 
to four decimal places. If you enter amounts in these fields, you 
would normally leave the Salary Per Period field blank. 

Salary.  If the employee is paid a salary, enter the employee’s 
normal salary for each pay period. If you enter an amount in this 
field, you would normally leave the Regular Per Hour and 
Overtime Per Hour fields blank. 

Hours Per Period.  If you pay the employee by the hour, enter 
the number of hours the employee normally works in the pay 
period. For salaried employees, this number is used to determine 
eligibility for Employment Insurance. 

Pay Periods Per Year.  Select from the list of possible pay 
periods, or type a valid number of pay periods. 

Retain Vacation.  Check the Retain Vacation box if you want to 
retain vacation pay and pay it out later. Then enter the 
percentage used to calculate vacation pay. Leave the box 
unchecked if you want to pay vacation pay with each cheque. 
This varies according to provincial legislation. 
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Record Wage Expenses In.  Employee wages are normally 
recorded in the accounts you linked for payroll. If you wish to 
record this employee’s wages in a different wage expense 
account, click the button to the right of The Payroll Linked 
Accounts option and enter an account. 

Deductions tab Note that the program can deduct amounts either before or 
after it calculates taxes. To specify when to make the 
deductions, choose System Settings and then Settings from the 
Setup menu, then click the Payroll Deductions tab and check or 
clear (uncheck) the boxes for each deduction.  

 Tip:  Using preset deductions saves time and helps prevent 
errors because you do not have to type the deduction amounts 
every time you issue a paycheque. 

If you need to, you can enter a different deduction amount when 
you record a paycheque in the Paycheques window. 

Pension, Group Insurance (Group Ins.), Medical, Misc 1, 
Misc 2, and Deductions 6 through 20.  Enter the amounts of 
pension contributions, group insurance, medical premiums, and 
miscellaneous deductions to be withheld from the employee’s 
pay for the period. If you have changed the names of the 
deduction fields (by choosing System Settings and then Names 
from the Setup menu), these fields display their new names. 

WCB and other 
expenses tab 

WCB Rate.  Enter the Workers’ Compensation Board 
assessment percentage that relates to this employee. The 
WCB Rate field accepts four decimal places. If Quebec is 
chosen in the Tax Table field, enter the assessment 
percentage which relates to CSST (Commission de la santé 
et de la sécurité du travail). 

User-Defined Expenses.  You can define up to five additional 
expense accounts to record employer expenses. For example, 
you can define an expense account to record the portion of an 
employee's insurance premium that is paid by the employer. 
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Entitlements tab Use the Entitlements tab to track an employee’s sick days or 
leaves of absence. You must enter the number of hours the 
employee normally works during a day of paid employment. 

Simply Accounting calculates the days earned based on this 
field. 

 

Exercise 11: Entering Employee Records 

 
Employees 

1. In the Home window, choose the Employees icon. 

2. From the File menu or the toolbar, choose Create. 

3. Enter the information for the employee record as 
follows: 

a) Click the Personal tab and enter: 

Employee:  Ashcroft, Howard 
Street 1: 63 Inglenook Drive 
City: New Westminster 
Province: British Columbia 
Postal Code: V9N 9E1 
Phone 1: 604 555 5432 
SIN: 306 921 123 
Birth Date: 04-16-1950 
Hire Date: 07-31-1993 

 
Calendar Note:  You can click the Calendar button to the right of the 

date fields to select a date from a calendar. 

b) Click the Taxes tab and enter: 

Tax Table: British Columbia 
Federal Claim: 7,912.00 
Federal Claim Subject to  
 Indexing: 7,412.00 
Provincial Claim: 8,500.00 
Provincial Claim Subject to  
 Indexing: 8,000.00 
Deduct EI: Yes    Rate 1.4 
Additional Fed. Tax: 0.00 
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c) Click the Income tab and enter: 

On the Regular line: 
      Amount Per Unit: 16.00  
     Hours Per Period: 80 
On the Overtime 1 line: 
     Amount Per Unit: 24.00 
On the Salary line:  
     Amount Per Unit:  0 
Pay Periods Per Year: 26 
Retain Vacation: Yes    Rate 4% 
Record Wage Expenses In: Payroll linked accounts 

d) Click the Deductions tab and enter a Percentage Per Pay 
Period for the following: 

Pension: 3.0 % 
Group Ins.: 0.75 % 
Medical: 1.0 % 

4. Click the WCB And Other Expenses tab and enter 4.25% as 
the WCB Rate. 

5. Click the Entitlements tab to enter the number of hours in a 
work day: 8.0 

6. Click Create Another to add the employee to your records. 

7. Repeat steps 3 to 5, entering the following information: 

a) Click the Personal tab and enter: 

Employee:  Smart, Pauline L. 
Street 1: 3701 Harmon Ave. 
Street 2: Apt 403 
City: Vancouver 
Province: British Columbia 
Postal Code: V2B 1Y8 
Phone 1: 604 555 3621 
SIN: 777 888 991 
Birth Date: 12-05-1967 
Hire Date: 05-08-1994 

b) Click the Taxes tab and enter: 
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Tax Table: British Columbia 
Federal Claim: 7,412.00 
Federal Claim Subject to Indexing: 7,412.00 
Provincial Claim: 8,000.00 
Provincial Claim Subject to Indexing: 8,000.00 
Deduct EI: Yes    Rate 1.4 
Additional Fed. Tax: 0.00 

c) Click the Income tab and enter: 

Salary Per Period: 2,100.00 
Salary Hours Per Period: 37.5 
Pay Periods Per Year: 26 
Retain Vacation: Yes    Rate 4% 
Record Wage Expenses In: Payroll linked accounts 

d) Click the Deductions tab and enter: 

Pension: 3.0% 
Group Ins.: 0.75% 
Medical: 1.0% 

e) Click the WCB And Other Expenses tab and enter 3% 
as the WCB Rate. 

f) Click the Entitlements tab to enter the number of 
hours in a work day: 8.0 

8. Close the window. 

9. To display the employee records you have just entered, in 
the Employees icon window, from the Reports menu, choose 
Display Employee List. 

Adding Inventory Records 
The Inventory and Services window contains records of all items 
and services that you sell. 

The Inventory and Services window looks similar to this (note 
that the Build tab appears only in Simply Accounting Pro and 
higher): 
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The fields and tabs that will appear depend on whether you 
specified the item type as Inventory or Service. You enter 
information in the following fields: 

Number.  Enter the inventory or service item number. 

Description.  Enter a description of the item. 

Type.  Choose whether the item is an inventory or service item. 

Activity (Time and Billing).  This box appears only if you 
specified service as the item type in Simply Accounting Pro or 
higher. Click this box if the service is to be included in the Time 
and Billing (Time Slips) process. 

Inactive Item.  Check this box if you no longer stock this item 
but want to keep the record for reference. 

Internal Service Activity.  This box appears in Simply 
Accounting Pro and higher, if you had specified service as the 
item type and checked the Activity (Time and Billing) box. Click 
this box if the activity is to be tracked for reporting within the 
company only (that is, the activity will not appear in the list of 
items to be billed and sold in the Sales, Orders and Quotes 
window). 
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Quantities tab The Quantities tab appears only if you choose Inventory in 
the Type field. 

Show Quantities In.  Select the unit of measure in which the 
quantities are shown, for example, dozen, kilogram, or 
tonne. You set the units of measure on the Units tab. 

Minimum Level.  Enter the minimum quantity you wish to have 
in stock. 

Units tab If you select a service item, the only field that appears on 
this tab is Unit of Measure. You do not need to differentiate 
between stocking, buying, or selling units of measure for 
services.  

In Simply Accounting Pro or higher, if you select a service item 
that you designated as an activity for Time and Billing, then the 
fields on the Units tab are unavailable for edit. Use the Time And 
Billing tab instead. 

Stocking Unit of Measure.  Enter the unit of measure in which 
you stock the item in your inventory, for example, dozen, 
kilogram, or tonne. 

Selling Units and Buying Units.  If you buy or sell items in a 
different unit of measure than the one in which you stock the 
item, uncheck the Same As Stocking Unit box under the Buying 
Units or Selling Units section. 

■ Unit of Measure.  Enter the unit of measure in which you 
buy or sell the item, such as dozen, kilogram, or tonne. 

■ Relationship.  Describes the relationship between the 
stocking unit and the buying or selling unit. Enter the 
number of stocked units that make up a buying or selling 
unit or vice versa. For example, if the stocking unit of 
measure is kilograms and selling unit is grams, you would 
enter 1000 in the first box, and select Grams per Kilogram in 
the second box: 

 



Adding Inventory Records 

Workbook    51 

 

SIM2005 CDN WB - PRINT.doc, printed on 10/12/2005, at 8:18:44 AM. Last saved on 
10/12/2005 8:15:00 AM. 

ACCPAC INTERNATIONAL, INC. Confidential 

Pricing tab Regular.  Enter the regular price at which you sell this item. 

Preferred.  Enter the preferred price for this item. 

Web Price.  Enter the price at which you sell this item on the 
Web. 

If you are using Simply Accounting Pro or higher, you may have 
additional prices to enter. 

Linked tab You can add the following accounts “on the fly” if they do 
not already exist. 

Asset.  This field appears if you chose Inventory in the Type 
field. From the list of accounts, select the asset account you want 
to associate with this inventory item.  

Revenue.  Select the revenue account you want to associate 
with this inventory item, service or activity.  

Expense.  This field appears if you chose Service in the Type 
field. Select the expense account you want to associate with this 
service.  

Cost of Goods Sold (C.O.G.S.).  This field appears if you chose 
Inventory in the Type field. Select the Cost Of Goods Sold 
expense account you want to associate with this inventory item.  

Variance.  This field appears if you chose Inventory in the Type 
field. The account records any difference in price caused by 
negative inventory levels. Select the variance account you want 
to associate with this inventory item. It can be the same account 
as the C.O.G.S. account.  

Time and Billing tab 
(Simply Accounting 
Pro or higher) 

The Time And Billing tab appears in Simply Accounting Pro 
and higher. You can edit this tab only for a service item that 
is a Time and Billing activity. After you complete this tab 
and create the item record, you can select the item when 
using the Time Slips window. 

Unit’s Relationship to Time.  Enter the following information: 

■ Unit of Measure.  Enter the unit of measure by which to 
measure this service activity. You can choose Hours or 
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Minutes from the drop-down list, or type your own value, 
such as Service Call.  

■ Unit is Related to Time.  If you enter hours or minutes in 
the Unit of Measure field, then Simply Accounting 
automatically selects the Unit Is Related To Time box. If the 
unit is not hours or minutes but can be measured in hours or 
minutes, check the Unit Is Related To Time box, then in the 
Relationship field, fill in the information about the item. 

■ Relationship.  If you selected the Unit Is Related To Time 
box, define the relationship that the unit has with time. For 
example, if a service call is defined as one hour per service 
call, enter 1 in the first Relationship field, and select Hours 
Per Service Call from the drop-down list of the second 
Relationship field. 

If you did not select the Unit Is Related To Time box, you do 
not need to define the relationship. 

Billing & Payroll Options.  Enter the following information: 

■ The Service Activity is.  Specify whether the activity is: 

− Billable — The charge for the service item (activity) will 
appear on the invoice. 

− Non-billable — The service item (activity) will not 
appear on the invoice. 

− No charge — The service item (activity) will appear on 
the invoice, but without a charge amount. 

■ Sometimes Charge for this Activity.  This field appears 
only if the Service Activity Is field is Non-billable or No 
Charge. Selecting the Sometimes Charge For This Activity 
option enables you to charge for the activity during Time 
Slips entry, even though the activity is normally non-billable 
or not charged. 

■ Charges are Based on.  You can edit this field only if you 
specified that the “unit is related to time” and that the 
service activity is “billable.” Then specify whether charges 
are based on: 
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− Billable Time — The amount charged for the service 
activity will be based on the time spent on the activity. 

− Flat Fee — If you choose this option, then you must 
further specify how the flat fee is defined, relative to the 
price. For example, the flat fee of a service call may 
actually be based on 1.25 hours of activity, even though 
the service call has been defined as only one hour in the 
“relationship to time” fields. 

■ Default Payroll Income.  You can specify the type of 
income normally associated with this service (for example, 
regular or overtime income). The value in this field 
automatically appears in the Payroll Income field of the time 
slip, so you don’t have to select it every time.  

Simply Accounting 
Pro or higher 

The Build tab appears in Simply Accounting Pro and higher, 
and only for an inventory item. After you complete this tab 
and create the item record, you can select the item when 
using the Bill of Materials And Item Assembly window. 

Build [  ] of this Item from the Following Components.  Enter 
the number of items that you will build on this bill. 

Then, in the table that lists the components, enter the following 
information: 

■ Item No.  Enter the item that you wish to include in this bill 
of materials. Simply Accounting will automatically display 
the item’s unit of measure and description. 

■ Unit and Description.  When you enter the item number, 
Simply Accounting automatically displays the item’s unit of 
measure and description.  

■ Quantity.  For the item number, enter the number of units 
required to build the bill of materials item. 

Additional Costs.  Enter any additional costs associated with 
this build, such as manufacturing overhead or direct labour.  

Record Additional Costs To.  Enter the account number to 
which to record the additional costs. 
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Taxes tab Tax and Tax Exempt.  The Taxes tab enables you to specify 
the taxes to charge on the item. Select one of the taxes listed 
in the Tax column. Then, in the Tax Exempt column, set to 
Yes or No by clicking the column: 

■ If the item is tax-exempt (that is, the tax is not to be charged 
on the item), set to Yes.  

■ If the item is not tax-exempt (that is, the tax is to be charged 
on the item), set to No. 

Additional 
Information tab 

Fields 1 to 5.  On the Additional Information tab, enter 
additional information about this item if you wish. You can 
rename each of the five fields by choosing Set Field Names from 
the File menu. 

Detailed Description 
tab 

Long Description.  Enter a detailed description of the item. You 
can choose to print the long description when you print the 
Inventory and Services List (from the Reports menu, choose 
Lists, then Inventory and Services). 

Picture.  You can associate pictures of inventory items with their 
inventory records. Pictures can be bitmap (*.BMP), JPEG (*.JPG, 
*.JPEG), or Graphics Interchange Format (*.GIF) files and should 
measure 120x120. 

Thumbnail.  You can store a smaller version of the picture that 
you associated with this item. 

Statistics and History 
tabs 

The fields on the Statistics and History tabs are described 
later in the Workbook under “Adding Historical Inventory 
Information.” 

Exercise 12: Entering Inventory Records 

 
Inventory & 

Services 

1. In the Home window, choose the Inventory And 
Services icon. 

2. From the File menu or the toolbar, choose Create. 

3. Enter inventory details as follows: 

a) Click the Quantities tab and enter: 
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Item Number: A13 
Item Description: Toner Cartridge 
Type: Inventory 
Minimum Level: 25 

b) Click the Units tab and fill in the information as follows: 

 

c) Click the Pricing tab and enter: 

Regular Selling Price: 100 
Preferred Selling Price: 97.50 

d) Click the Linked tab and enter: 

Asset: 1520 
Revenue: 4020 
C.O.G.S.: 5020 
Variance: 5020 

Note:  You will fill in the remaining fields in 
“Exercise 16: Entering Historical Inventory Details.” 

Click the Taxes tab and enter the following so that GST 
and PST will be charged on this item: 

GST Tax Exempt: No 
PST Tax Exempt: No 
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4. Click Create Another to accept the information and open a 
new record. 

5. Repeat steps 3 and 4, entering the following two item 
records: 

Item Number:  A15 A18 
Item Description: User’s Guide Web Server 
Type: Inventory Inventory 
Minimum Level: 5 5 
Stocking Unit of  
 Measure: Each Each 
Regular Selling  
 Price: 30 3200 
Preferred Selling 
 Price: 25 3150 
Asset: 1530 1540 
Revenue: 4030 4040 
C.O.G.S.: 5030 5040 
Variance: 5030 5040 
GST Tax Exempt: No No 
PST Tax Exempt: No No 

6. Close the Inventory And Services Records window. 

7. To review the inventory items entered, in the Inventory And 
Services icon window, from the Reports menu, choose 
Display Inventory And Services List.  

Adding Projects 
You use the Projects module to list the names and the start dates 
of projects you are working on. When you use the other modules 
to enter day-to-day transactions, you can allocate amounts to 
projects through their transaction windows. (The Projects 
module has a reporting role only; it does not have its own 
transaction window.) 
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The Project records window looks like this: 

 

The window contains the following fields: 

Project tab Project.  Enter the project name. 

Start Date.  Enter the date your company started work on the 
project. The date displayed automatically is the session date. 

Revenue.  Enter the revenue generated by the project prior to 
the start date. If you are starting a new project, leave the balance 
forward amount at 0.00. 

Expense.  Enter the expense incurred by the project prior to the 
start date. If you are starting a new project, leave the balance 
forward amount at 0.00. 

Status.  Identify whether this project is currently active: 
Pending, In Progress, Cancelled, Completed. 

Inactive Project.  Check this box if you no longer use this 
project but want to keep the record for reference. 
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Additional 
Information tab 

Fields 1 to 5.  Enter additional information about this project if 
you wish. You can rename each of the five fields by choosing Set 
Field Names from the File menu. 

Exercise 13: Entering Project Records 

 
Project 

1. In the Home window, choose the Project icon. 

2. From the File menu or the toolbar, choose Create. 

3. Enter the following information: 

Name: Police Academy 
Start Date: 10-21-2015 
Revenue: 78,514.00 
Expense: 59,872.00 

The Project record should look like this: 

 

4. Click Create Another. 

5. Enter the following two projects, clicking Create Another 
after entering each one: 

Name: Arthritis Society 
Start Date: 11-05-2015 
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Revenue: 124,714.00 
Expense: 99,637.00 

Name: Mayfield, Green and Associates 
Start Date: 01-01-2015 

6. Close the Project Records window. 

7. To review the projects you entered, in the Project icon 
window, from the Reports menu, choose Display Project 
List.  

Entering Historical Financial Data 
Now that you have created the accounts and records that you 
need, you can enter historical accounting data. You should enter 
account balances as of the earliest transaction date, based on the 
trial balance taken from your manual records. The program 
automatically calculates balances for subtotal, group total, and 
current earnings accounts. (For an explanation of account types, 
see “Account Types” in Chapter 2 in the User Guide.) 

 

 
History symbol 

Until you choose the Finish Entering History command (on the 
History menu), all the modules display a History symbol, 
indicating that you can enter historical data. 

Simply Accounting modules are set up to accept both historical 
and current transactions concurrently; you do not need to finish 
entering historical data before entering new transactions. History 
can be added to any module until you choose the Finish Entering 
History command or until the end of your company’s first fiscal 
year. 

Exercise 14: Entering Historical Balances in the Accounts 

1. In the Home window, choose Accounts. 

2. For each of the following accounts, enter these opening 
balances in the Opening Balance field on the Account tab: 

1050 Petty Cash 50.00 
1055 Saving Bank Account 2,200.00 
1060 Chequing Bank Account 2,533.11 
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1100 Investments 4,000.00 
1200 Accounts Receivable 6,000.00 
1320 Prepaid Expense 710.00 
1520 Computer Supplies 4,875.00 
1530 Manuals 1,500.00 
1540 Computer Hardware 15,450.00 
1820 Office Furniture and Equipment 5,000.00 
1825 Accum. Amort. –Furn. & Equip. -3,000.00 
1840 Vehicle 6,000.00 
1845 Accum. Amort. -Vehicle  -4,500.00 
2120 Bank Loan - Current Portion 34,302.25 
2185 CPP Payable 845.00 
2230 WCB Payable 592.00 
3010 Owner’s Contribution 100.00 
3560 Retained Earnings - Previous Year 5,993.36 
5430 CPP Expense 422.50 
5440 WCB Expense 592.00 

3. Close the Accounts window. 

Note:  If you have mistyped one of the amounts above, then 
Simply Accounting warns you that the debits and credits are 
not equal and that it will assign the difference to the 
Retained Earnings account. Click OK and correct the values 
in the chart of accounts. 

4. To display the historical information you just entered, in the 
Accounts icon window, from the Reports menu, choose Trial 
Balance. Your total debits and total credits — at the bottom 
of the report — should balance. 

Adding Historical Sales Data 
Before you finish entering history, the Accounts Receivable 
account balance must equal the total of unpaid invoices for all 
customers. 

In the previous exercise, you entered a $6,000 balance in the 
Accounts Receivable account. Now you must make sure that the 
total of all customer balances in the Customers window is $6,000. 
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Simply Accounting calculates the customer’s balance, based on 
information you enter about the customer’s invoices and 
payments, as of the earliest transaction date. This information is 
called a customer’s “history” or “historical data.” 

 To add historical sales data, choose the Customers icon to 
display a customer record. Click the Historical Transactions 
tab, and then click the Invoices button. 

The Historical Invoices window looks like this: 

 

You enter information in the following fields: 

Invoice No.  Enter an invoice number. The program does not 
allow you to enter duplicate or blank invoice numbers. 

Date.  Enter the invoice date. The earliest transaction date is 
displayed automatically, but you can change it if you wish. 

Terms.  Enter the payment terms you offered this customer. The 
program fills in the payment terms you added in an earlier 
exercise, but you can change them if you wish. 

Amount.  Enter the amount of the invoice. 

Exercise 15: Entering Historical Sales Details 

1. In the Home window, choose the Customers icon. 

2. Open the record for Management Consulting. 

 3. Click the Historical Transactions tab, and then click the 
Invoices button. 

4. Enter the following invoice details: 
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Number:  A458 
Date: 01-11-2014 
Terms: Accept the terms  
 (0 %, 0 days, Net 30) 
Amount:  4,000.00 

The Historical Invoices window should look like this: 

 

5. Click Record to accept the information. 

6. Click Close to tell the program you have finished entering 
this customer’s historical invoices. 

7. In the Select field, select Action Line. 

 8. Click the Historical Transactions tab, and then click the 
Invoices button. 

9. Enter the following information: 

Number:  A620 
Date 11-25-2014 
Terms: Accept the terms 
Amount:  2,000.00 

10. Click Record, then click Close. 

11. Close the window. 

12. To review the information you entered: 

a) From the Customers icon window, choose the Reports 
menu, then Customer Aged. 

b) Select the Detail option. 

c) Click the Select All button. 
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d) Check the Include Terms and Include Historical 
Difference boxes. 

e) Click OK. 

If you made a 
mistake 

If you entered a historical invoice incorrectly, you must clear 
the invoice. To do this, open the customer’s record, and on  
the Historical Transactions tab, click the Payments button. Pay 
the invoice in full, then click Record. Modify the invoice number 
and re-enter the invoice correctly. 

Adding Historical Inventory Information 
Before you finish entering history, the total value of inventory 
items must equal the total of the associated asset account(s) in 
the Accounts window. 

You should therefore enter a quantity and value for each item in 
your inventory. This is called “historical” inventory information. 

In Exercise 14, you entered inventory asset account balances in 
the Accounts window. The accounts are Computer Supplies, 
Manuals, and Computer Hardware. Now you must enter the 
values for the individual inventory items in the inventory 
records. You must make sure, for example, that the total value of 
inventory associated with the asset account Computer Hardware 
is $15,450, the amount you entered earlier in the Accounts 
window. 

In these exercises, only one inventory item is associated with 
each asset account, but that may not always be true. 

You enter historical information in the following fields: 

On the Statistics tab Show Units Sold In.  Select the unit of measure in which the 
data on this tab is measured. You set the units of measure on 
the Units tab. 

Year To Date.  Enter the number of transactions, units sold, 
amount sold, and cost of goods sold for the current fiscal year. 

Last Year.  Enter the number of transactions, units sold, amount 
sold, and cost of goods sold for the previous fiscal year. 
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Date Of Last Sale.  Enter the last date on which you sold some 
of this item. 

On the History tab Opening Quantity.  Enter the number of items in stock as 
of the earliest transaction date. 

Opening Value.  Enter the total cost of the stock on hand as of 
the earliest transaction date. 

Exercise 16: Entering Historical Inventory Details 

1. In the Home window, choose the Inventory and Services 
icon. 

2. Open the record for A13 Toner Cartridge. 

3. On the Statistics tab, enter the following: 

Show Units Sold In: Each 
In the Last Year section: 
 Number Of Transactions: 22 
 Units Sold: 35 
 Amount Sold: 3500.00 
 Cost Of Goods Sold (C.O.G.S.): 2625.00 
Date Of Last Sale: 08-04-2014 

The Statistics tab of the Inventory and Services record 
should look like this: 
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4. On the History tab, enter the following: 

Opening Quantity: 65 
Opening Value: 4,875.00 

5. Scroll to items A15 and A18, entering the following 
information for them: 

Statistics Tab Item Number: A15 A18 
Show Units Sold In: Each Each 
Number Of Transactions: 45 7 
Units Sold: 49 9 
Amount Sold: 1,470.00 28,800.00 
Cost Of Goods Sold: 1,078.00 22,500.00 
Date of Last Sale: 12-14-2014 12-19-2014 

History Tab Opening Quantity: 60 6 
Opening Value: 1,500.00 15,450.00 

6. Close the Inventory And Services Records window. 

7. To review the inventory details: 

a) In the Inventory And Services icon window, from the 
Reports menu, choose Synopsis. 

b) Select the Inventory By Asset, Stocking Units, and Item 
Synopsis options. 
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c) Check the Include Historical Difference box. 

d) Click the Select All button, and then click OK. 

e) Repeat steps a) through d), but select the Inventory By 
Item option instead of the Inventory By Asset option. 

Finish Entering History 
You can continue to change account balances or other 
information, and you can delete records without restriction, until 
you set up Simply Accounting to accept only new transactions 
using the Finish Entering History command. 

You should finish entering history by the end of the first fiscal 
year, prior to completing year-end activities. If you have not 
finished entering history, Simply Accounting will not allow you 
to start a new year.  

Before you finish entering history, ensure that the balances of all 
the modules (such as Customers or Vendors) equal the balances 
of their respective linked accounts. To check for differences, 
display or print the reports for modules in which you entered 
history, using the option to include historical differences. For 
example, when you display the Customer Aged report, be sure 
to select Include Historical Difference. The report then includes a 
line indicating whether the balance for the module matches the 
balance in the linked account. 

Back up your data It is important to back up your data before choosing the 
Finish Entering History command. Once you finish entering 
history, you cannot enter additional historical information. 

 
Backup In the Home window, choose Backup from the File menu or 

toolbar, then fill in the screen. For more details, see “Backing 
Up Your Company’s Information” in Chapter 19 in the User 
Guide. 
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Exercise 17: Finish Entering History 

Be certain that the fiscal start, fiscal end, and earliest transaction 
dates are correct (as you set up earlier in Exercise 1). To check 
these dates, choose Company Information from System Settings 
on the Setup menu. 

To set up Simply Accounting to accept only current 
transactions: 

1. In the Home window from the History menu, choose Finish 
Entering History. 

A warning appears, telling you to back up your data before 
proceeding. If you have not already backed up your data, 
click the Backup button. 

2. Click Proceed. 

The History symbols disappear from the modules on the 
Home window, indicating that you can no longer enter 
historical information. 

Entering Purchases 
To record a purchase of inventory or services, you use the 
Purchases, Orders, and Quotes window. When you record 
purchases of inventory or services, the Vendors And Purchases, 
Inventory And Services, and General modules are affected. 

The Purchases, Orders, and Quotes window looks like this: 
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You enter information in the following fields: 

Transaction.  The appearance and function of the Purchases, 
Orders, and Quotes window varies, depending on the type of 
transaction you select: 

■ Invoice.  For recording details of an invoice from your 
suppliers (vendors) for a purchase you made. 

■ Purchase Order.  For recording details of goods or services 
you are ordering. (You will receive and pay for them later.) 

■ Quote.  For recording details quoted by your suppliers for 
goods or services you might want to purchase later. (You 
can convert the quote into an order or invoice if you decide 
to make the purchase later.) 

The program stores the information from purchase orders and 
quotes for tracking purposes only; it does not update the 
accounts until you record a purchase invoice. 

Details of cash purchases appear in the Transactions By Account, 
All Transactions, and Purchase Transaction Details reports.  

Paid By.  Select a payment method from the list. 

Purchased From.  Select a vendor from the list; the program 
automatically enters the vendor’s address. 
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If the vendor is not listed, you can enter a one-time vendor. Type 
the vendor’s name, press the Tab key, and click Continue. You 
must pay one-time vendors at the time of purchase. 

Ship To.  If you select Purchase Order or Quote in the 
Transaction field, the program displays this field and fills in 
your company’s name and address. You can accept this 
information or type over it. 

Order/Quote Number (PO Number).  If you select Purchase 
Order in the Transaction field, the program automatically enters 
the next available purchase order number. You can accept it or 
type a different number or word to identify the order. 

If you want to fill an existing purchase order, select Invoice in 
the Transaction field, and then Pay Later, Cash, Cheque, or a 
credit card in the Paid By field. Then enter the purchase order 
number. The program fills in the fields for the purchase, which 
you can accept or change. 

Cheque.  If you select Cheque in the Paid By field, the program 
automatically enters the next available cheque number. You can 
accept this number, or type a different number or word to 
identify the transaction. 

Invoice.  If you select Invoice in the Transaction field, enter the 
number of the vendor’s invoice for this purchase. If you select 
Purchase Order or Quote, this field does not appear. 

Ship Date.  If you select Purchase Order or Quote in the 
Transaction field, enter the date by which you need to receive 
the order. 

Date.  Enter the date of the invoice, or accept the date displayed. 
The date can be any date between the earliest transaction date 
and the session date, inclusive. If you selected the option Allow 
Transactions In The Future, on the System tab in System 
Settings, you can enter any date between the earliest transaction 
date and the last day of the fiscal year, inclusive. 

Item.  Enter the item number, or press Enter and select one from 
the list. The Unit, Description, Price, and Account (Acct) fields 
are filled in automatically, using values you entered in the 
Inventory or Service record. 
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Quantity.  If you are filling a purchase order, enter the quantity 
received. If this differs from the quantity ordered, the program 
automatically fills in the difference in the Back Order (B/O) 
field. 

Order.  Enter the number of items being purchased or ordered. 

Back Order (B/O).  If you are filling a purchase order, the 
program automatically fills in the difference between the 
quantities ordered and received. You can accept this number, or 
change it. 

Unit.  Enter the item’s buying unit, for example, dozen, kilogram, 
or tonne. 

Description.  Enter a description of the item. 

Price.  Enter the cost of the inventory item. On a purchase order, 
enter the quoted or advertised price; you can adjust it later if the 
price changes. 

Tax.  Enter a tax code for the item, and the program will 
automatically calculate and display the taxes that are defined by 
the tax code. You create tax codes by using the Sales Tax 
Information window (from the Setup menu, select System 
Settings, then Sales Taxes). 

Tax Amount (such as GST, PST).  If you have defined more than 
two taxes in your system, then the program calculates and 
displays the item’s total tax amount (based on the tax code that 
you selected) in the Tax Amount field. If you have defined only 
one or two taxes in your system, then the program displays a 
separate tax field for each tax, such as a GST and a PST field. 

Amount.  If you have entered a quantity and a price, the 
program calculates the amount automatically. If you wish, enter 
a different amount; the program recalculates the price. 

Account (Acct).  The program fills in the asset account for this 
item, as listed in the Inventory or Service record. 

If no account number appears, enter the number of the account 
to debit or credit for the item. 
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Allocate Allocate (Allo).  You can allocate the cost of a non-inventory 

item to a project. (Inventory items are usually allocated when 
you sell the item.)  

If you want to allocate the cost of inventory items, check the 
Allow Project Allocations box in the asset account record 
associated with the item(s). 

Click the Allocate button. The Project Allocation window 
appears. You enter information in the following fields. 

Apply This Allocation To Entire Transaction.  Check this box if 
you want to allocate all detail lines in the transaction to the same 
project in the same amounts or percentages. This box is selected 
by default if you chose it as a user preference (on the Setup 
menu in the Home window, choose User Preferences, then 
Settings, and then check the option, Always Apply Allocation to 
the Entire Transaction). 

Project.  Double-click or press Enter to display a list of projects, 
then select one. 

Amount.  Since you chose to allocate other transactions by 
amount (in Exercise 4), you can change the Amount field. The 
percentage field is calculated based on what you enter in the 
Amount field. (You could also have chosen to allocate by 
percentage.) 

Enter the dollar amount to be allocated to the project. You can 
allocate all or part of the remaining amount among additional 
projects by selecting each project, then entering the amount. The 
program displays the total amount to be allocated and the 
remaining amount, at the top of the window. 

When you have completed your allocation, a check mark 
appears in the Allocate column beside the detail line, in the 
Purchases window. 

Invoice Received.  If you selected Invoice in the Transaction 
field, but did not receive an invoice with your shipment, clear 
(uncheck) this box. The Invoice field name then changes to 
Reference. If you later try to pay for the shipment you are 
recording now, the program will warn you to look for the 
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invoice, so you can enter any shipping costs or changes in price 
or payment terms. 

Freight.  Enter the cost of freight that cannot be directly 
allocated to a specific item. If the freight can be allocated to a 
specific item, include it in the Amount field for the item. 

Tax totals (such as GST, PST).  If you have defined more than 
two taxes in your system, then the program calculates and 
displays in the Tax totals field, the total tax amount for all items. 
If you have defined only one or two taxes in your system, then 
the program displays a separate tax field for each tax total, such 
as a total GST and a total PST field.  

Terms.  If you select Purchase Order or Quote in the Transaction 
field, or if you selected Invoice in the Transaction Field and Pay 
Later in the Paid By field, the program automatically displays 
three fields and fills in the payment terms listed in the vendor’s 
record. 

You can accept these terms, or change them if the vendor invoice 
differs. For purchase orders, enter the payment terms this 
supplier generally offers you. If you have no invoice now, you 
can fill in payment terms later, when you receive the invoice. 

Payment terms include an early-payment discount rate (percent) 
and period (in days), and the number of days until the invoice is 
due in full. 

Discount.  If you select Cash, Cheque, or a credit card as the 
payment method, the program automatically displays two fields 
in which you can enter a cash discount, if you received one. 
Enter the percentage or the lump sum of the discount. In either 
case, the program deducts the discount from the total, and 
shows the new total in the Amount Paid box. 

Exercise 18: Entering Inventory Purchases 

Change the session 
date 

When you chose settings for your company in Exercise 1, 
you left the option Allow Transactions In The Future 
(beyond the session date) unchecked. 

The current session date is January 1, 2015. Because the option 
Allow Transactions In The Future is not selected, you cannot 
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process transactions with a date later than the session date. To 
record transactions dated after January 1, 2015, you must 
advance the session date to the date you need. 

To change the session date: 

1. Close all records and transaction windows. 

 
Change 
Session Date 

2. In the Home window, from the Maintenance menu or 
the toolbar, choose Change Session Date. 

 
Backup If you have not yet backed up your data, the program 

asks whether you want to do so. Click Yes and follow 
the instructions on the screen. For more details see 
“Backing Up Your Company’s Information” in 
Chapter 19 in the User Guide. 

3. Enter 01-03-2015 as the new session date, and click OK. 

After you change the session date, the Daily Business Manager 
and the Checklists windows appear. Close these windows. If you 
do not want them to appear every time you advance the session 
date, from the View menu, select User Preferences, and then 
Daily Business Manager, and uncheck the After Changing 
Session Date option. Again from the View menu, select User 
Preferences, and then Checklists, and uncheck the After 
Changing Session Date option. 

To enter a purchase: 

 
Purchases, 

Orders & Quotes 

1. In the Home window, open the Purchases, Orders, and 
Quotes window. 

2. Select Invoice in the Transaction field, and Pay Later in the 
Paid By field. 

3. Move from field to field, entering or accepting the following 
information: 

Purchased From: Software Unlimited 
Invoice: 2245 
Date: 01-03-2015 
Item:  A15 
Quantity:  10 
Price: Accept the price displayed 
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Tax code: GP 
Amount: Lower the total amount owing by 
 entering 205 (the program  
 adjusts the Price field to 20.50 when 
 you leave the Amount field) 
Freight: Enter 5 in the freight field (the final 
 field) 
Invoice Received: Yes 

The window should look like this: 

 

4. To review the transaction before processing it, from the 
Report menu, choose Display Purchase Transaction Detail. 
Close the report when you are finished. 

 
5. Click the Process button. 

6. Repeat the same procedure for the following purchase: 

Purchased From: Hart Computer Supplies 
Invoice: 397 
Date: 01-03-2015 
Item:  A13 
Quantity: 5 (boxes) 
Price: 75.00 
Freight: Leave blank 

7. Close the Purchases, Orders, and Quotes window. 
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8. In the Home window from the Reports menu, select 
Transaction Details and then Purchases, to review the 
transactions. Accept the start and end date range 
of 01-03-2015 by clicking OK. 

Entering Payments 
To record payment of a purchase or a prepayment to a vendor, 
you use the Payments window. You can also use this window to 
pay credit-card bills or to make other payments not necessarily 
associated with an invoice, such as phone bills or loan payments. 

The window looks like this: 

 

Transaction Type (the first field).  Select the type of payment 
you want to make. You can choose to pay purchase invoices that 
you have entered or pay a credit-card bill that you have 
received. You can also select the Make Other Payment option, 
which allows you to make a payment without entering an 
invoice. 

By.  You can select to pay by cash, cheque, or a credit card that 
you have set up. You can set up the credit cards you accept 



Entering Payments 

76    Simply Accounting 

 

SIM2005 CDN WB - PRINT.doc, printed on 10/12/2005, at 8:18:44 AM. Last saved on 
10/12/2005 8:15:00 AM. 

ACCPAC INTERNATIONAL, INC. Confidential 

using the Credit Card window (on the Setup menu choose 
System Settings and then Credit Cards). 

From.  If you are paying by cash or cheque, you can select the 
bank account from which you will withdraw the funds. 

To The Order Of.  Select the individual or company that you are 
paying. 

No./Source.  If you are paying by cheque, you can enter the 
cheque number in this field. Otherwise, this field is named 
Source, and you can type another identifier for the payment 
(such as Cash or Credit Card). 

Date.  The day on which you make the payment. 

If you select Pay 
Purchase Invoices 

Once you select the vendor that you want to pay, a list of unpaid 
invoices appears. The following fields also appear: 

Invoice/Pre-payment (Invoice/Pre-pmt.).  The invoice or 
prepayment reference number. 

Original Amount (Original Amt.).  The amount on the invoice 
or the amount of the prepayment. 

Amount Owing (Amt. Owing).  The amount left to pay on an 
invoice or the amount of a prepayment that you can apply to an 
invoice. 

Discount Available (Disc. Available).  The amount you will 
save, according to your payment terms, by paying the invoice 
before the discount expires. This field is calculated 
automatically, based on the payment terms of the original 
invoice. 

Discount Taken (Disc. Taken).  The discount already applied to 
the invoice. 

Payment Amount (Payment Amt.).  The amount that you are 
paying or the amount of the prepayment that you are applying. 
You can pay the entire invoice or just a part.  
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Include Fully 
Paid Invoices/ 
Prepayments 

Click the Include Fully Paid Invoices/Prepayments button if you 
need to list fully paid invoices, so you can reverse all or part of a 
fully paid invoice (to correct an error or to account for an NSF 
cheque). 

If you select Pay 
Credit Card Bill 

If you select Pay Credit Card Bill, the following field appears: 

Payment Amount.  The amount that you are paying to the 
credit-card company. 

If you select Make 
Other Payment 

If you select Make Other Payment, the following fields appear: 

Account (Acct.).  The account this payment will debit or credit. 

Description.  A description of an item that you are paying. 

Amount.  The amount you are paying. 

The remaining fields are the same as described in the section 
“Entering Purchases,” earlier in the Workbook. 

Exercise 19: Paying an Invoice 

Allow future 
transactions 

1. Before you begin, set Simply Accounting to allow future 
transactions. In the Home window from the Setup menu, 
choose System Settings and then Settings. Under Company, 
choose System, and check Allow Transactions In The Future 
(Beyond The Session Date). Then click OK. 

 
Payments 

2. Open the Payments window. 

3. In the first three fields, select Pay Purchase Invoices, Cheque, 
and 1060 Chequing Bank Account. 

4. In the To The Order Of field, select Software Unlimited. 

5. In the Date field, type 01-08-2015 (the day on which you 
make the payment). 

6. In the Discount Taken field, type 10. 

7. Click the Payment Amount field. The full amount of the 
invoice, minus the discount, appears.  
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8. In the Comment field, type Discount taken for late delivery. 
The should look like this: 

 

9. To print the cheque, choose Print from the File menu. 

10. Click Process.  

Exercise 20: Making a Miscellaneous Payment 

1. Open the Payments window. 

2. In the Transaction Type field (the first field), select Make 
Other Payment. 

3. In the By field, select Cheque. Simply Accounting 
automatically enters the principal chequing bank account. 

4. In the To The Order Of field, type D&P Charities, and press 
the Tab key. You have not entered a record for this vendor, 
so Simply Accounting asks if you want to add the name to 
your vendor list. Click Continue to use this name without 
entering a record. 

5. In the Account field, type 5740 and press Tab. 

6. In the Description field, type Money for charity event, in the 
Amount field, type 200, and in the Tax field, click the 
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magnifying glass button and select No Tax. The Payments 
window should look like this: 

 

7. Choose Print from the File menu to print the cheque. 

8. Click Process. 

Entering Inventory Sales 
To create sales invoices for inventory items, you use the Sales, 
Orders, and Quotes window, which looks like this: 
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If you plan to use Simply Accounting to print invoices, fill in the 
information described below, and the program prints it on the 
invoice. If you plan to produce invoices by some other method 
(such as filling in by hand), you can skip some of the fields, as 
noted. 

Enter information in these fields:  

Transaction.  The appearance and function of the Sales, Orders, 
and Quotes window varies, depending on the type of transaction 
you select: 

■ Invoice.  For recording details of a sale to a customer. 

■ Sales Order.  For recording a customer’s order that you will 
deliver later. When you fill the order, you can convert the 
sales order to an invoice. 

■ Quote.  For recording a sales quote to your customer. (You 
can convert the quote to an order or invoice later.) 

Details of all sales invoices appear on the Transactions By 
Account, All Transactions, and Sales Transaction Details reports.  

Paid By.  You can select Pay Later for customers for whom you 
have entered a customer record, or you can select Cash, Cheque, 
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or a credit card you have set up. You must select Cash, Cheque, 
or a credit card for one-time customers. 

For more information about entering sales paid by cash, cheque, 
or a credit card at the time of sale, see “Entering a Sale” in 
Chapter 13 in the User Guide. 

Sold To.  Select a customer from the list; the program fills in the 
customer’s address. If the customer is not on the list, you can 
enter a one-time customer. (Type the customer’s name, press the 
Tab key, and click Continue.) You must receive payment from 
one-time customers at the time of sale. 

Ship To.  If you select a customer from the list, the program fills 
the Ship To field with the ship-to address you entered in the 
customer record. 

Invoice.  The invoice number displayed automatically is the 
next number in the series of invoice numbers. If you wish, you 
can type a different number. 

Ship Date.  If you select Sales Order or Quote in the Transaction 
field, enter the date by which you need to ship the order. 

Date.  Enter the date of the invoice, or accept the date displayed. 

Item.  Enter the item number of the item you are selling. If you 
do not know the item number, press Enter to display a list of 
items, then select one. The program fills in the Unit, Description, 
Price, and Account fields. You can also add an item “on the fly” 
by choosing <Add New Inventory/Service> from the list of 
items, clicking the Add button, and then filling in the 
information on the screen. 

Quantity.  If you are entering a sales invoice, enter the number 
of units you are selling. 

Order.  If you are entering a sales order or quote, enter the 
number of units on order. 

Back Order (B/O).  If you are entering a sales order, the 
program automatically fills in this field with the same number 
you entered in the Order field. When you fill in the sales order 
later, the program automatically adjusts the Back Order amount. 
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Unit.  The program enters the item’s selling unit (such as each, 
dozen, or kilogram) listed in the inventory or service record. 

Description.  The program enters the item’s description listed in 
the inventory or service record. 

Price.  The program fills in this field automatically. If you wish, 
enter a different price. The field accepts up to four decimal 
places.  

Amount.  If you have entered a quantity and a price, the 
program calculates the amount automatically. If you wish, enter 
a different amount; the program recalculates the price. 

Tax.  Enter a tax code for the item, and the program will 
automatically calculate and display the taxes that are defined by 
the tax code. You create tax codes by using the Sales Tax 
Information window (from the Setup menu, select System 
Settings, then Sales Taxes). 

Account (Acct).  The program fills in the revenue account for 
this item, as listed in the inventory or service record. 

If no account number appears, enter the number of the account 
to debit or credit for the item. This would normally be a revenue 
account. 

 
Allocate Allocate (Allo).  You can allocate the revenue from the sale 

of an item to a project. Choose Allocate from the Sales menu, 
click the Allocate toolbar button, or use the Tab key to enter 
the field; the Project Allocation window appears. You enter 
information in the following fields. 

■ Project.  Double-click or press Enter to display a list of 
projects, then select one from the list. 

■ Amount.  Since you chose to allocate by amount (in 
Exercise 4), the Amount field is available. (You could also 
have chosen to allocate by percentage.) 

■ Enter the dollar amount to be allocated to the project. You 
can allocate all or part of the remaining revenue from the 
item among additional projects by selecting each project, 
then entering the amount. The program displays the total 
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amount to be allocated and the remaining amount at the top 
of the window. 

When you have completed your allocation, a check mark 
appears in the Allocate column beside the detail line in the Sales, 
Orders, and Quotes window. 

Freight.  Enter the cost of freight that cannot be directly 
allocated to a specific item. 

The amount is added to the linked Freight Revenue account 
when you process the transaction. 

Tax totals (such as GST, PST).  If you have defined more than 
two taxes in your system, then the program calculates and 
displays in the Tax totals field, the total tax amount for all items. 
If you have defined only one or two taxes in your system, then 
the program displays a separate tax field for each tax total, such 
as a total GST and a total PST field.  

Comments.  The invoice comment entered on the Comments 
tab in the System Settings window appears automatically in this 
field. You can change it if you wish. 

Terms.  If you select Sales Order or Quote in the Transaction 
field, or if you select Invoice in the Transaction Field and Pay 
Later in the Paid By field, the program automatically displays 
three fields and fills in the payment terms listed in the 
customer’s record. 

The program automatically includes invoices that have payment 
terms in the To-Do Lists. Among other things, you can use the 
To-Do Lists to keep track of: 

■ Recurring sales you should ship and invoice this week. 

■ Customers with overdue accounts, and the balance due. 

Discount.  If you select Cash, Cheque, or a credit card as the 
payment method, the program automatically displays two fields 
in which you can enter a discount, if you wish. You can enter a 
discount either as a percentage of the total amount owed, or as a 
lump sum. In either case, the program deducts the discount from 
the total, and shows the new total in the Amount Received box. 
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Sold By.  If you use Job Categories, you can specify which 
employees are salespersons and choose one for this invoice. 

Exercise 21: Entering Sales Invoices 

 
Sales, Orders & 

Quotes 

1. Open the Sales, Orders, and Quotes window. 

2. Select Invoice in the Transaction field, and Pay Later in the 
Paid By field. 

3. In the Sold To field, select Software Corp. 

4. Move from field to field, entering the following information: 

Invoice: 429 
Date: 01-03-2015 
Item: A18 
Quantity: 1 
Tax code: GP (GST 7%, PST 7.0%) 

Accept the entries displayed for unit, description, selling 
price, and account. When you enter the quantity, the 
program calculates the amount, GST, PST, and total amount. 

5. On the next line, enter this information: 

Item A15 
Quantity: 3 
Tax code: GP 

The Sales, Orders, and Quotes window should look like this: 
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The program enters the 
payment terms listed in 
Software Corp.’s customer 
record. 

 

6. To check the accuracy of your work before processing, 
choose Display Sales Transaction Detail from the Report 
menu. Close the report. 

7. To print the invoice, choose Print from the File menu or the 
toolbar.  

The program displays the message: “The invoice number 
you entered is greater than the next number in your invoice 
numbering sequence. Do you want the next invoice to 
continue with this new numbering?” Click Yes. 

8. Click the Process button. 

If the program displays the invoice numbering warning, 
click Yes. 

9. Close the Sales window. 

10. In the Home window from the Reports menu, choose 
Customers And Sales, then Customer Aged to check your 
work. Select the Detail option, then select Software Corp., 
and then click OK. Close the window once you have looked 
at the report. 

11. To review the transaction, from the Reports menu, select 
Transaction Details and then Sales. Accept the dates 
displayed, and click OK. 
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Looking Up Invoices 
You can store and look up the details of invoices, orders, and 
quotes for both sales and purchases. 

Store invoices To have the program store invoices to look up later, you 
must check the Store Invoice Lookup Details box. (In the 
Home window on the Setup menu, choose System Settings, 
Settings, then Company, and then System.)  

 
To look up invoices, you use the Invoice Lookup feature 
available in the Sales, Orders, And Quotes, and Purchases, 
Orders, And Quotes windows. 

 

If you know the invoice or the transaction number, you can enter 
it in the window and view the invoice directly. If not, you can 
browse a list of invoices by clicking the Browse button. If you do 
not know the invoice or transaction number, enter information 
into as many other fields as possible to narrow down the list.   

You enter information in the following fields: 

Start and Finish.  Enter the date or range of dates you want the 
program to include. 

Customer Name or Vendor Name.  Enter the name of the 
customer or vendor whose invoice you want to look up. 
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Invoice Number.  Enter the number of the invoice. If you do 
not know the number, click the Browse button, then select the 
invoice from the list. 

Transaction Number. Enter the transaction number. If you do 
not know the transaction number, click the Browse button to 
select an invoice from the list. 

To look up an order or quote, open the window in which you 
created it (either Purchases, Orders, And Quotes or Sales, 
Orders, And Quotes), select the order/quote number, and press 
Tab. 

Amount.  Enter the amount of the invoice. If you do not know 
the amount, click the Browse button, then select the invoice from 
the list. 

Exercise 22: Looking Up a Sales Invoice 

1. Open the Sales, Orders, and Quotes window. 

 
Look up an 
invoice 

2. Click the Look Up An Invoice button on the toolbar, or 
press Ctrl+L to display the Invoice Lookup window. 

3. In the Customer Name field, select Software Corp. 

 4. Click the Browse button to display Software Corp.’s 
invoices: 
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 5. Click the Select button, or press the Enter key to select 
the highlighted transaction (the sales invoice you 
entered in the previous exercise). 

Because the program has already updated the customer 
account with this invoice, you cannot change any of the 
displayed information.  

6. Click the Print toolbar button to reprint the invoice. Then 
close the Sales, Orders, and Quotes window. 

Entering a Credit Memo (Customer Refunds) 
When a customer returns merchandise, you must enter the 
return as a negative invoice in the Customers And Sales 
window. When you process the invoice, the program updates 
the Inventory And Services, General, and Customers And Sales 
modules. When you create a negative invoice (credit memo), the 
program automatically credits the linked Accounts Receivable 
account. 

Exercise 23: Entering a Credit Memo 

1. Open the Sales, Orders, And Quotes window. 

2. Select Invoice in the Transaction field, and then Pay Later in 
the Paid By field. 

3. In the Sold To field, select Software Corp. 

4. Move from field to field, entering or accepting the following 
credit memo details: 

Invoice: CR 25 
Date: 01-05-2015 
Item: A13 
Quantity: -1 (negative number) 
Tax code: GP 
Acct:  4020 
Comments: Return -- our invoice #429 dated Jan 3, 2015 
Terms: Clear all three fields 
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The window should look like this: 

 

5. To review the transaction before processing, from the Report 
menu, choose Display Sales Transaction Detail. Close the 
window. 

6. If you want to print the credit memo, in the Sales, Orders, 
And Quotes window, choose Print from the File menu or the 
toolbar. 

7. Click Process. 

8. Close the transaction window. 

9. To review the reduction in the customer account: 

a) In the Home window from the Reports menu, choose 
Customers And Sales, then Customer Aged. 

b) Select the Detail option and then Software Corp. 

c) In the As At field, select 01-05-2015. 

d) Click OK. 

10. To review the transaction, in the Home window from the 
Reports menu, select Transaction Details and then Sales. 
Change the Finish date to 01-05-2015, and then click OK. 
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Entering a Sales Receipt 
To record a payment received for an unpaid invoice or to record 
a customer deposit, you use the Receipts window. 

If you are receiving payment for goods at the same time as you 
are selling them, you can use the Sales, Orders, And Quotes 
window to process both the invoice and the payment, without 
having to open the Receipts window.  

The Receipts window looks like this: 

 

You enter information in these fields: 

Paid By. You can select cash or cheque or a credit card, if you 
have set them up (in the Home window, on the Setup menu, 
choose Settings, then Credit Cards). 

Deposit To.  You can select any bank or cash account to which 
you want to deposit this payment. 

Cheque.  If the customer is paying by cheque, enter the cheque 
number.  
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From.  From the list of customers, select the customer whose 
payment you wish to record. A list of unpaid invoices appears at 
the bottom of the screen. 

Number (No.).  Enter the receipt number. 

Date.  Enter the date for processing this receipt; for example, the 
date of the cheque used to pay the invoices. 

Invoice/Deposit.  The program lists all unpaid invoices and 
unused deposits for this customer. The program can also list 
fully paid invoices (described at the end of this section). 

Original Amount (Original Amt.).  For each invoice listed, the 
program displays the total of the original invoice before 
early-payment discounts or payments. 

Amount Owing (Amt. Owing).  For each invoice listed, the 
program displays the unpaid portion of the original amount. 

Discount Available (Disc. Available).  Using the date you 
entered in the Date field and the payment terms from the invoice 
(not shown on this screen), the program calculates whether the 
customer qualifies for an early-payment discount, and fills in 
this field. 

Discount Taken (Disc. Taken).  The discount amount applied to 
the invoice. 

Payment Amount (Payment Amt.).  The program uses the 
Amount Owing and Discount Taken fields to calculate and fill in 
the total amount paid. To display the amount, click in or Tab to 
the Payment Amount field of the invoice. 

If the customer is paying less than the full amount, type over the 
amount displayed. If an amount appears and you have not 
received any payments for that invoice, press Delete to remove 
it. 

 
Include Fully 
Paid Invoices/ 
Deposits 

Click the Include Fully Paid Invoices/Deposits button if you 
need to list fully paid invoices, so you can reverse all or part of a 
fully paid invoice (to correct an error, or to account for a 
customer’s NSF cheque).  
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Exercise 24: Entering a Sales Receipt 

1. Change the session date to 01-05-2015, using the steps 
described in Exercise 18. 

 
Receipts 

2. Open the Receipts window. 

3. Move from field to field, entering or accepting the following 
information: 

Paid By:                Cheque     
Deposit To: 1069: Central Bank: Richmond  
Cheque: 450 
From: Management Consulting  
No.:  141 
Date: 01-05-2015 
Payment Amt.:  4000.00 (Full payment of invoice A458) 

The Receipts window should look like this: 

 

4. To check the transaction before processing it, from the 
Report menu, choose Display Receipt Transaction Detail. 
Then close the report window. 

5. From the File menu or the toolbar, choose Print. 

6. Click Process. 
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A message appears, telling you that the receipt number you 
entered is greater than the next number in the sequence. It 
asks whether you want the next receipt to continue with the 
new numbering. Click Yes. 

7. Repeat steps 3 through 6 for the following information: 

Deposit To: 1069: Central Bank: Richmond 
Cheque: 358 
From:  Action Line 
Date:  01-05-2015 
Payment Amt.: 200 (Partial payment of invoice A620)  

8. Close the Receipts window. 

9. To review the results of the transactions: 

a) In the Home window from the Reports menu, select 
Customers And Sales, and then Customer Aged. 

b) Choose the Detail option, and click the Select All button. 

c) Check the Include Terms box, and then click OK. 

d) Close this report window. 

10. To review the transactions, in the Home window from the 
Reports menu, select Transaction Details and then Receipts. 
Select 01-01-2015 as the start date, and accept 01-05-2015 as 
the finish date, then click OK. 

Entering a Customer Deposit 
Occasionally, you may request that a customer pays a deposit for 
ordered items. You can use the Receipts window to record 
customer deposits. 

(If you want to make a prepayment to a vendor, you use the 
Payments window.) 

Exercise 25: Entering a Customer Deposit 

1. Open the Receipts window. 
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Enter 
Customer 
Deposits 

2. Click the Enter Customer Deposits toolbar button. 

3. Enter these deposit details: 

Paid By: Cash 
From: Software Corp. 
No: 143 
Date: 01-05-2015 
Deposit Reference No.: 100 
Deposit Amount: 200 

The Receipts window should look like this: 

 

4. To check the accuracy of the transaction, choose Display 
Receipt Transaction Detail from the Report menu. Then close 
the report. 

5. Print the deposit receipt by choosing Print from the File 
menu or clicking the Print toolbar button. 

6. Click Process. 

If a warning appears about the number sequence, click Yes 
to continue with new numbering sequence. 

7. Close the Receipts window. 
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8. To review the reduction in the customer account, in the 
Home window from the Reports menu, choose Customers 
And Sales, then Customer Aged. Select the Detail option, 
and then select Software Corp. Click OK. 

9. To check your work, in the Home window from the Reports 
menu, select Transaction Details and then Receipts. In the 
Start Date, enter 01-05-2015 and click OK. 

Entering Miscellaneous Transactions  
The Miscellaneous Transactions window is used to make all 
entries that cannot be made in other transaction windows. 

In the Miscellaneous Transactions window, you can process 
transactions affecting all accounts except the linked Accounts 
Payable, Accounts Receivable, Payroll Advances, and Vacation 
Payable accounts, inventory asset accounts, and Current 
Earnings accounts. You cannot update these linked accounts 
directly. Their balances are changed only through the related 
transaction windows, or when the program automatically 
calculates the balance of the Current Earnings account. 

The Miscellaneous Transactions window looks like this: 

 

You enter information in these fields: 
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Source.  Enter the source document number you want to store 
with the transaction; for example, enter a cheque number or 
invoice number. 

Date.  Enter the date on which you entered the transaction. 

Comment.  Enter a description or reason for the transaction. 

Account.  Enter the account number that you want to debit or 
credit. You can type in the number, or select it from the list of 
accounts by double-clicking the field. You can also create a new 
account “on the fly” by choosing <Add new account> from the 
list of accounts. 

Debits.  Enter the amount you want to debit the account. 

Credits.  Enter the amount you want to credit the account. 

Comment.  If you wish, you can enter a description for each line 
of the transaction. 

 
Allocate Allocate.  You can allocate amounts to projects or 

departments, if the account is set up to allow project 
allocations. Click the Allocate button in the toolbar to display 
the Project Allocation window. You enter information in the 
following fields. 

■ Project.  Double-click or press Enter to display a list of 
projects, then select one from the list. 

■ Amount.  Since you chose to allocate by amount (in 
Exercise 4), the Amount field is available. (You could also 
have chosen to allocate by percentage.) 

Enter the dollar amount to be allocated to the project. You 
can allocate all or part of the remaining amount among 
additional projects by selecting each project, then entering 
the amount. The program displays the total amount to be 
allocated and the remaining amount at the top of the 
window. 

When you have completed your allocation, a check mark 
appears in the Allocate column beside the detail line, in the 
Miscellaneous Transactions window. 
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You can store a transaction that you use on a regular basis and 
recall it whenever you need it. See “Using Recurring 
Transactions,” later in the Workbook, for details. 

Exercise 26: Entering Miscellaneous Transactions 

To enter miscellaneous transactions: 

 
Miscellaneous 
Transactions 

1. Open the Miscellaneous Transactions window. 

2. Move from field to field, entering the following 
information: 

Source: 29 
Date: 01-05-2015 
Comment: To increase petty cash $100 

3. Click the magnifying glass in the Account field. Select and 
enter 1060 Chequing Bank Account. 

4. Move to the Credits field, then type 100. 

5. Tab to a new line, then select account 1050 Petty Cash. 

6. In the Debits field, press Tab to accept the amount of 100.00. 

The Miscellaneous Transactions window should look like 
this: 
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7. To check the transaction before processing it, choose Display 
Miscellaneous Transaction Detail from the Report menu. 
Close the report window when you are finished. 

8. Click the Process button to update your accounts. 

9. Repeat the same procedure for the following transaction: 

Source: Transfer 
Date: 01-03-2015 
Comment: To transfer from savings to chequing 
Account: 1060 Chequing Bank Account 
Debits: 1200 
Account: 1055 Savings Bank Account 
Credits: 1200 

10. Close the Miscellaneous Transactions window. 

Paying Employees 
Simply Accounting uses the information you entered in each 
employee’s record to calculate payroll cheques. Be certain that 
all payroll records are correct before issuing a paycheque for an 
employee. 

Note:  A Payroll ID is required if you want to complete the 
payroll exercises using automatic tax calculations. 

To record a payroll cheque, you use the Paycheques window, 
which looks like this: 
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Enter information in the following fields: 

Direct Deposit This Paycheque.  Select this option if you have 
registered for this service and set up the Direct Deposit option 
for this employee. 

To The Order Of.  Select an employee from the list. 

No.  The program fills in a cheque number for you. You can type 
a different number, if you wish. 

Date.  Enter the date on which you issue the cheque, or accept 
the date displayed. 

Period Ending.  Enter the ending date of the pay period to be 
covered by the cheque. The date displayed is the session date. 

Income tab - Earnings Regular (Reg.).  If the employee is paid by the hour, enter the 
number of regular hours worked by the employee during the 
pay period. The program multiplies this number by the regular 
hourly rate entered in the employee’s record to determine the 
regular pay amount earned during the period. 

Overtime (OT 1 and OT 2).  Enter the number of overtime hours 
worked at each overtime rate. The program multiplies these 
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numbers by the overtime hourly rates entered in the employee’s 
record to determine the amount of overtime pay earned during 
the period. 

Salary.  Enter the number of hours per pay period in the Hours 
column and the amount of pay in the Amount column. If a 
salary amount and number of hours per pay period have been 
entered in the employee’s record, the program fills these in for 
you. You can type a different amount of pay if needed. 

Commission.  Enter any commission earned in the pay period. 

Income tab - Other Advance.  Enter the amount advanced to the employee, which 
will be taken off a future cheque. 

Benefits.  Enter the amount of any taxable benefits received by 
the employee during the pay period. 

Vacation Accrued.  Enter the amount of vacation pay to be 
paid to the employee for this period. 

Vacation Paid.  Enter the amount of vacation pay retained from 
prior periods to be paid with this paycheque. 

Deductions tab Pension, Group Insurance, Medical, Miscellaneous 1 and 2.  
The amounts entered originally in the Employee Record is 
displayed.  

Taxes tab EI, CPP/QPP, and Tax.  Since you checked Automatic Payroll 
Deductions as a Payroll option in Exercise 1, the fields for federal 
and provincial payroll taxes are not accessible. The program 
calculates these amounts automatically. 

 
Allocate Allocate.  You can allocate payroll expenses to projects. Click 

the Allocate button to display the Project Allocation window. 
You enter information in the following fields: 

■ Project.  Double-click or press Enter to display a list of 
projects, then select one. 

■ Amount.  Since you chose to allocate payroll expenses by 
amount (in Exercise 4), the Amount field is available. (You 
could also have chosen to allocate by percentage or hours.) 
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Enter the dollar amount to be charged to the project. You can 
allocate all or part of the remaining expense among additional 
projects by selecting each project, then entering the amount. The 
total amount to be allocated and the remaining amount are 
displayed at the top of the window. 

Exercise 27: Entering Payroll Transactions 

This is a two-part exercise. In part 1, you will add enough money 
to the Payroll Bank account to cover the paycheques you will 
issue, and in part 2, you will enter payroll transactions. 

Part 1: Increasing the Payroll Bank Account 

When you use separate bank accounts for different functions in 
your business, you need to keep track of your account balances. 
You want to avoid having an overdrawn account, and you want 
to keep large amounts of cash in a higher interest-bearing 
account. 

Data Processing Services has begun to earn revenues, and 
receipts are starting to come in. However, to earn those 
revenues, the company has had to incur expenses. Payroll is 
usually a significant expense for a service company, and Data 
Processing Services is no exception. The Payroll Bank account 
does not have sufficient cash to meet the payroll. Therefore, 
before entering paycheques, you must transfer cash into the 
Payroll Bank account. 

1. In the Home window, choose Miscellaneous Transactions. 

2. Enter the following information: 

Source: Transfer 
Date: 01-10-2015 
Comment: To increase Payroll Bank account 
Account: 1060 Chequing Bank Account 
Debits: 4000 
Account: 1069 Central Bank: Richmond 
Credits: 4000 

3. Click Process and then close the Miscellaneous Transactions 
window. 
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Part 2: Payroll Transactions 

1. Change the session date to 01-15-2015. A message tells you 
that the session date is more than a week past your previous 
session date. Click OK. 

 
Paycheques 

2. In the Home window, open the Paycheques window. 

3. Move from field to field on the Income tab, entering or 
accepting the following information: 

To The Order Of: Smart, Pauline L. 
No.: 125 
Date: 01-15-2015 
Period Ending: 01-15-2015 
Salary: When you click or tab to the Salary 

field, the program fills in the number of 
hours (37.50) and amount of pay per 
pay period ($2100)  from the payroll 
records. 

Commission: 100 
Vacation Accrued: The vacation field is automatically 

updated as a percentage of total 
earnings (salary + commission). 

The window, with the Income tab selected, should look like 
this: 
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Calculate Taxes 
Manually 

4. If you do not have a Payroll ID, the Calculate Taxes 
Manually button on the toolbar is enabled. Calculate this 
employee’s taxes using the correct tax tables. Refer to the 
current income tax publications issued by the Canada 
Revenue Agency (CRA). 

  

Calculate Taxes 
Automatically 

5. If you entered a Payroll ID during setup, you can calculate 
taxes automatically (click the Calculate Taxes automatically 
button on the toolbar). Depending on the tax table you use, 
the amounts for EI, CPP, and Tax may differ from the 
amounts shown on the Taxes tab: 

 

6. To review the transaction before processing it, choose 
Display Payroll Transaction Detail from the Report menu. 
Close the window. 

7. To print the paycheque, choose Print from the File menu. 
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8. Click Process. 

The program will display the message: “The cheque number 
you entered is greater than the next number in your cheque 
numbering sequence. Do you want the next cheque to 
continue with this new numbering?” Click Yes, and the 
program will then use 126 as the next cheque number. 

The program may also display the following message: “The 
payroll formulas being used are valid only for session dates 
[    ] to [    ]. Are you sure you want to continue with this 
transaction?” 

This message means that the program’s payroll formulas are 
not valid for the 2015 session date you entered. Since this is 
only an exercise, you do not have to be concerned with this 
message. Click Yes to process the transaction. 

9. Enter the following information for another employee: 

To The Order Of: Ashcroft, Howard 
No.: 126 
Date: 01-15-2015 
Period Ending:  01-15-2015 
Reg.: 80 
OT 1: 5 

 
Allocate 10. Click the Allocate button, then click the magnifying glass 

in the Project field. Click Arthritis Society, and click 
Select.  

11. Accept the amount displayed, and click OK.  

12. Repeat steps 4-6 to review and process your transaction. 

13. Close the Paycheques window. 

14. To review your employee records, in the Home window 
from the Reports menu, choose Payroll, then Employee. 
Select the Summary option, click Select All, and click OK. 
Close the window once you have reviewed the information. 

15. To review transactions, from the Reports menu, choose 
Transaction Details and then Payroll. Accept the start and 
finish dates displayed by clicking OK. 
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Adjusting Paycheques 
If you discover an error in a paycheque after it has been 
processed, you can reverse it, and then enter a new transaction 
with the correct information, as described under “Correcting 
Errors on Paycheques” in Chapter 15 in the User Guide. 

Or, you can adjust the existing cheque by looking it up, 
correcting the errors, and processing the adjustment. However, 
because income tax deductions are complex, you should avoid 
adjusting paycheques, unless: 

■ You are adjusting the most recent cheque you paid to the 
employee, and 

■ The employee has not reached the maximum deduction 
levels for EI, WCB, or CPP. 

Exercise 28: Adjusting a Paycheque 

In this exercise, you will adjust Pauline Smart’s salary from 
$2100 to $1890 because she took some time off without pay. 

1. In the Home window, open Paycheques. 

 
Adjust 
Paycheque 

2. On the Paycheque menu or the toolbar, choose Adjust 
Paycheque, then select the most recent paycheque for 
Pauline Smart (click Browse). 

Simply Accounting reminds you to recalculate the 
taxes on the cheque after you make any adjustments. 
Click anywhere in the box to close it. 

3. Move from field to field, changing only the information in 
these fields: 

No.: 125 ADJ 
Salary Hours: 32 
Salary: 1890 
Commission: 100 

 
Recalculate 
Taxes 

4. On the Paycheque menu or the toolbar, choose 
Recalculate Taxes. Do not forget this step. 
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Note:  If you do not have a Payroll ID, you must recalculate 
taxes manually. Refer to the current income tax publications 
issued by the Canada Revenue Agency (CRA). 

The Paycheques window should look like this: 

  

After you enter the new 
salary amount, remember 
to recalculate the taxes. 

 

Depending on the tax table you use, the deduction amounts 
may differ from those shown in this example: 

 

5. To review the transaction before processing it, choose 
Display Payroll Transaction Detail from the Report menu. 
Then, close the window. 

 
Print 6. Print the new paycheque. 

If you had printed a real paycheque in Exercise 27, you 
would write “VOID” on it and replace it with the new 
paycheque. 

7. In the Paycheques window, click Process. 
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8. Close the Paycheques window. 

9. In the Home window on the Reports menu, select Payroll, 
then Employee. Select the Summary option, select Pauline 
Smart, and then click OK. Review the employee record. The 
gross pay should be $1,990.00 ($1,890 in salary and $100 in 
commissions). 

Entering Inventory Adjustments 
During the fiscal year, inventory items may become damaged, 
broken, or obsolete. Also, inventory loss or shrinkage may occur. 
You use the Inventory Adjustments window to record any 
changes to the inventory quantity. 

The window looks like this: 

 

You enter information in these fields: 

Source.  Enter the source document number. 

Date.  Enter a date, or accept the one displayed. 
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Comment.  You can use this optional field to describe the 
transaction in more detail. 

Item.  Enter the number of the item to be adjusted; or, 
double-click or press Enter, then select the inventory item from 
the list. The program fills in the Unit, Description, and Unit Cost 
fields from the inventory record for this item.  

Quantity (Qty).  If the stock is to be increased, enter a positive 
quantity. If stock is to be reduced, enter a negative quantity. 

Amount.  The unit cost multiplied by the quantity. You can 
accept the amount calculated by the program, or enter a different 
amount. 

Account.  Enter the expense account that will record the 
inventory adjustment, or accept the Adjustment account you 
have linked to the item. To change the account, press Enter, then 
select the account from the list. When you process the 
adjustment, the program automatically updates the linked 
inventory asset account and the expense account. 

 
Allocate Allocate.  If you entered an account that allows project 

allocations, click the Allocate button to allocate the amount 
of this adjustment to one or more projects. A Project 
Allocation window appears. You enter information in the 
following two fields. 

■ Project.  Double-click or press Enter to display a list of 
projects, then select one. 

■ Amount.  Since you chose to allocate by amount (in 
Exercise 4), the Amount field is available. (You could also 
have chosen to allocate by percentage.) 

Enter the dollar amount to be allocated to the project. You 
can allocate all or part of the remaining amount among 
additional projects by selecting each project, then entering 
the amount. The program displays the total amount to be 
allocated and the remaining amount at the top of the 
window.  
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When you have completed your allocation, a check mark 
appears in the Allocate column beside the detail line, in the 
Inventory Adjustments window. 

Exercise 29: Entering an Inventory Adjustment 

1. Open the Inventory Adjustments window. 

2. Move from field to field, entering the following information: 

Source:  12 
Comment:  Damaged goods 
Item:  A13 
Quantity:  -2 

The window should look like this: 

 

3. To review the transaction before processing, choose Display 
Adjustment Transaction Detail from the Report menu. Close 
the report when you are finished. 

4. Click Process. 

5. Close the Inventory Adjustments window. 

6. To review the transaction, in the Home window from the 
Reports menu, select Transaction Details, and then Inventory 
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Adjustments. In the Start Date, enter 01-15-2015 and click 
OK. 

Using Recurring Transactions 
Simply Accounting lets you store copies of transactions and 
recall them for future use. You can store and recall transactions 
for any of the following transaction windows: 

■ Miscellaneous Transactions. 
■ Purchases, Orders, and Quotes. 
■ Payments. 
■ Sales, Orders, and Quotes. 
■ Paycheques. 
■ Item Assembly (and Bill of Materials in Simply Accounting 

Pro and higher ). 
■ Inventory Adjustments. 
■ Time Slips (Simply Accounting Pro and higher). 

 
Store As 
Recurring 
Transaction 

The two recurring-transaction buttons — Store and Recall — 
appear in the toolbar at the top of the windows. 

The Store Recurring Transaction window looks like this: 

 

You enter information in these fields: 

Recurring Transaction.  Enter the name you want to give the 
recurring transaction. Each recurring transaction must have a 
unique name. 

Frequency.  Select the frequency of the transaction. If the 
transaction does not take place regularly, select Random. 
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Recall 
Recurring 
Transaction 

After you have stored a transaction, you can recall it using 
the Recall Recurring Transaction button. The Recall 
Recurring Transaction window looks like this: 

 

Exercise 30: Storing a Recurring Transaction 

1. Open the Payments window and enter the following 
information: 

Transaction Type: Make Other Payment 
By: Cheque 
From: 1060 Chequing Bank Account 
No.: 102 
Date: 01-15-2015 
Acct: 2120 Bank Loan – Current Portion 
Description: Bank loan payment 
Amount: 500 
Tax: No tax 
Comment: Loan payment to Central Bank. 

2. In the To The Order Of field, type Central Bank: Richmond, 
and press Tab. 

3. When Simply Accounting warns that no record exists for the 
name you entered, click the Quick Add button to add a 
vendor record under this name. You can open the vendor 
record later to enter more details, such as the bank’s address. 
The Payments window should look like this: 
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Store As 
Recurring 
Transaction 

4. Click the Store button or press Ctrl+T to store the recurring 
transaction. 

 

5. Click OK or press Enter to accept the recurring transaction 
name and the frequency (monthly). 

6. Close the Payments window. The program asks you if you 
want to discard the displayed transaction. Click Yes to 
discard it. You will process it in Exercise 31. 

Exercise 31: Recalling and Processing a Recurring Transaction 

1. Open the Payments window. 

2. In the Transaction Type field (the first field), select Make 
Other Payment. 
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Recall 
Recurring 
Transaction 

3. Click the Recall button (or press Ctrl+R) to display a list 
of all stored transactions. 

 

4. Double-click the transaction you added, or highlight it and 
click the Select button. 

5. In the Comment field, add the word January to the 
beginning of the line. 

6. Choose Print from the File menu to print the cheque. 

7. Click the Process button to update the accounts.  

8. Select Make Other Payment, and click the Recall button 
again to look at the list of recurring entries: 

 

Note that the next due date for this transaction has changed 
to February 15, one month after the transaction you just 
processed. 

9. Click Cancel to return to the Payments window. Then close 
the Payments window. 
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Bank Reconciliation 
Once you have set up your accounts for reconciliation, Simply 
Accounting can help you automate the reconciliation of 
statements. When you receive a bank or credit-card merchant 
statement, you can use the Reconciliation and Deposits window 
to compare transactions on the statement with your Simply 
Accounting transactions and account for any differences. 

The screen you use to reconcile accounts looks like this: 

 

Transaction.  Use this window to complete an account 
reconciliation or prepare a deposit slip. 

Account.  Select the bank account that you want to reconcile. 

Statement Start/End Date.  Enter the period-start and end 
dates from the bank statement. 

Reconciliation Date.  Enter the actual date you are processing 
the reconciliation. 

Statement Opening/Ending Balance.  Enter the starting 
and/or ending balance shown on the bank statement.  

Comment.  Enter a brief description of the reconciliation. 
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Sort Transactions By.  Select a display option to view 
transactions: date, source, comment, deposit or withdrawal 
amount, or order of entry.  

Exercise 32: Reconciling Your Bank Account 

You receive the following bank statement: 

Central Bank 01-15-2015
Richmond Branch 
Date Transaction Amount 
01-01-2015 OPENING BALANCE $0.00 
01-08-2015 Deposit: Cheque #141, 

Batch 010815 
$4,000.00 

01-08-2015 Deposit: Cheque #142, 
Batch 010815 

$200.00 

01-08-2015 Deposit: Cheque #143, 
Batch 010815 

$200.00 

01-10-2015 Bank Transfer -$4,000.00 
01-15-2015 Interest $0.25 
01-15-2015 Bank Charges -$4.00 
 ENDING BALANCE $396.25 

This is a two-part exercise in which you will reconcile this 
statement with the corresponding transactions in Simply 
Accounting. In part 1, you will prepare the Central Bank account 
for account reconciliation. In part 2, you will complete the 
reconciliation. 

Part 1: Preparing the Bank Account for Reconciliation 

1. Open the Accounts window, and double-click the account 
1069 Central Bank: Richmond. 

2. Click the Reconciliation and Deposits tab, and check the 
Save Transactions For Account Reconciliation box. 

3. Click the Setup button. In this window, set the linked 
accounts for revenue and expenses that regularly appear on 
your bank statements. Enter or select the following options: 
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4. Click OK and close the Accounts window. 

Part 2: Reconciling your Account for the first time 

1. Open the Reconciliation and Deposits window. 

2. In the Account field, select 1069 Central Bank: Richmond. 
You should see a set of instructions entitled First 
Reconciliation. 

3. Enter the following dates, in this order: 

Reconciliation Date: 01-15-2015 
Statement End Date: 01-15-2015 
Statement Start Date: 01-01-2015 

Because you opened this account on January 1, the balance 
from your last statement is $0.  

4. In the Statement End Balance field, type the balance from the 
bank statement, which is 396.25. 

5. In the Comment field, type January statement.  

6. To specify that you do not have any transactions from an 
earlier period waiting to be processed, click the Add Prior 
Outstanding button, then click OK.  

The Reconciliation and Deposits window now lists current 
outstanding transactions: 
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7. In the Deposit No. column, enter the number 010815 for the 
first three transactions, and enter the number 011015 for the 
transfer. 

8. Once you have checked that the amounts on your bank 
statement match the amounts on this screen, select the 
transactions that have cleared the bank by clicking in the 
Cleared ( ) column. 

Note:  To assign the same status to all transactions with the 
same deposit number, click the heading of the Cleared 
column. This way you can reconcile deposits reported as a 
lump sum on the bank or merchant statement, but recorded 
in Simply Accounting as several different receipts. 
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9. Notice that $3.75 still needs to be resolved. This is because 
you still need to account for the bank interest and charges. 
Select the Income tab. 

10. On the Income tab, enter the following information: 

Source No.: Statement 
Date: 01-15-2015 
Comment: January bank interest 
Account: 4440 Interest Revenue 
Amount: 0.25 

11. Select the Expense tab, and fill in the following: 

Notice that Simply Accounting uses the linked accounts that 
you set up in the first part of this exercise. 

Source No.: Statement 
Date: 01-15-2015 
Comment: January bank charges 
Account: 5690 Interest and bank charges 
Amount: 4.00 

12. Simply Accounting now shows that you have $0 unresolved. 
Click Process to complete the reconciliation, then close the 
Reconciliation and Deposits window. 
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Foreign Currencies 
If you do business outside of your country, you can use Simply 
Accounting to keep track of transactions in a foreign currency. 

Once you have set up the foreign currency, you can add foreign 
cash and bank accounts, set foreign prices, and add foreign 
vendors and customers. 

When purchasing or selling items, the vendor or customer that 
you select determines the currency used on an invoice. If you 
select a foreign customer, Simply Accounting uses foreign prices 
on the invoice. 

The Basic version of Simply Accounting allows you to use two 
currencies; Simply Accounting Pro and higher allows you to use 
as many as you need. 

The setup screen for currencies looks like the following for 
Simply Accounting Pro and higher: 

 

Allow Transactions in a Foreign Currency.  Select this option 
to prepare Simply Accounting to handle another currency, such 
as US dollars. 
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Home Currency.  Select the currency of the country in which 
your company resides. If you cannot find the currency that you 
want to use, you can type it in the field and fill in the remaining 
fields manually. 

By default, the home currency is Canadian dollars. On most 
reports, any foreign balances will be converted into this 
currency. 

Currency Code.  An abbreviation of the currency. 

Symbol.  The symbol that represents the country’s currency, 
such as $ for dollars or £ for pounds. 

Symbol Position, Separators, Decimal Places.  Fill in the 
values for the currency you have selected. 

Denomination.  Specify the currency type you want used for 
deposit slips.  Simply Accounting uses the denomination type 
available for the currency you choose (for example, CDN $5, $10, 
$20… or USD $1, $2, $5, $10…). 

Track Exchange and Rounding Differences In.  Select a 
revenue or expense account in which you can track differences 
due to changes in the exchange rate over time. 

Foreign Currency.  Select the other currency in which you want 
to conduct business. If you cannot find the currency that you 
want to use, you can type the name. 

Exchange rates If you are using the Basic version of Simply Accounting, the 
following options appear on the same screen as the ones 
described above. In Simply Accounting Pro and higher, these 
options appear on the Exchange Rate tab. 

Select a Foreign Currency.  Select the currency for which you 
want to enter an exchange rate. 

Display a Reminder if the Exchange Rate is [     ] Old.  Select 
this option if you want Simply Accounting to remind you that 
the exchange rate may be out of date. You can select a warning 
period from the list. 
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Exchange Rate Table.  Use this table to enter exchange rates 
and dates. 

Exercise 33: Entering Transactions in a Foreign Currency 

This exercise is in two parts. In part 1, you will set up a foreign 
currency. In part 2, you will create a foreign customer, and sell 
that customer an item. 

Preparing to use 
foreign currency 

Before you set up a foreign currency, you must add an account to 
track exchange-rate changes and rounding. Account 5650 
Currency Exchange and Rounding in the Data Processing 
Services company is set up for you to use. 

Exchange-rate 
changes 

When you purchase or sell an item, payment is often made or 
received in the future. If the item’s price is in a foreign currency, 
the exchange rate may change before payment. This means that 
the equivalent price in your home currency also changes. 
Sometimes this works in your favour, sometimes not. 

Let’s say you purchase an item for $100 US. On the day of the 
purchase, the exchange rate is 1.65, so the price in Canadian 
dollars is $165. Some time later, when you are ready to pay the 
vendor’s invoice, the exchange rate has changed, and the US 
dollar is worth $1.60 CDN. You pay your vendor $100 US (worth 
$160 CDN). You have gained $5 CDN. 

Rounding The final price of an item paid for in foreign currency may also 
change due to rounding that occurs when the exchange rate is 
calculated. 

For example, if you purchase two items and pay in a foreign 
currency, US dollars, the entries might appear as follows. The 
foreign currency is worth 1.5997033 Canadian dollars. 

Account Foreign Currency 
Amount 

Debits Credits 

1540 
Hardware 

534.99  855.83  

1560 Lumber 35.00  55.99  

2220 Accounts    
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Account Foreign Currency 
Amount 

Debits Credits 

Payable 569.99 ______ 911.81 

Total:   911.82 911.81 

As Simply Accounting converts the transactions to the home 
currency, it rounds each line individually. However, as shown in 
the example above, this can result in small differences in the 
totals. Such differences are recorded in the Currency Exchange 
and Rounding account, as shown below.  

Account Foreign Currency 
Amount 

Debits Credits 

1540 
Hardware 

534.99 855.83  

1560 Lumber 35.00  55.99  

2220 Accounts 
Payable 

569.99   911.81 

5650 Currency 
Exchange and 
Rounding 

  
______ 

 
 0.01 

Total:   911.82 911.82 

Part 1: Setting Up the Foreign Currency 

1. In the Home window from the Setup menu, choose System 
Settings, and then Currencies. 

2. Check the Allow Transactions In A Foreign Currency box. 

3. In the Track Exchange And Rounding Differences In field, 
select 5650 Currency Exchange & Rounding. 

4. In the Foreign Currency field, select United States Dollars. 
Notice that Simply Accounting automatically fills in the 
remaining fields. 

5. If you are using Simply Accounting Pro or higher, click the 
Exchange Rate tab and select United States Dollars. 
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6. In the Exchange Rate table, click in the Date column, and 
type 01-15-2015. 

7. Click in the Exchange Rate column, and type 1.305. 

8. Select the Display A Reminder If The Exchange Rate Is [     ] 
Old option. 

9. In the box below, select One Week. 

10. Click OK. 

Part 2: Entering a Foreign Transaction 

1. In the Home window, from the Maintenance menu, choose 
Change Session Date. If Simply Accounting asks you if you 
want to back up your data, click No. 

2. Type 01-20-2015, and click OK. 

3. Open the Customers window. 

 
Create 4. Click the Create button on the toolbar, and enter the 

following record: 

On the Address tab Customer: University Association 
Contact: David Jones 
Street 1: 425 Main Street 
City: Seattle 
Province: Washington 
Postal Code: 98158 
Country: USA 
Phone 1: (216) 555 1234 
Fax: (216) 555 5678 
E-mail: djones@ua.org 

On the Ship-To 
Address tab 

Same As  
Mailing Address:  Yes 

On the Options tab Currency: USD 
Price List:                         Preferred 
Terms:  0%, 0 Days, Net 30 
Produce Statements: Yes 
 [     ] Forms For  
 This Customer: E-mail 
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  5. Click the Save and Close button. 

6. Open the Sales, Orders, and Quotes window.  

7. In the Sold To field, select University Association. 

8. In the Item field, type A15, and in the Quantity field, type 2. 

To calculate the price of the item, Simply Accounting 
chooses the exchange rate from the date closest to the 
transaction’s date. 

 
Exchange 
Rate button 

9. Click the Exchange Rate button located next to the Exchange 
Rate field. 

10. In the Exchange Rate table, click below the date 01-15-2015, 
and type 01-20-2015. 

11. In the Exchange Rate column, click beside the date you just 
entered and type 1.3064. The table should look like this: 

 

12. Make sure the rate you just entered is selected, and click OK.  

Note:  If you want to keep one price for inventory and 
service items, you can set separate foreign prices. In the 
Home window on the Setup menu, choose System Settings, 
then Settings. Under Inventory and Services, select the 
option to use the foreign price listed in the inventory or 
service record. 
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13. Simply Accounting will ask if you want to recalculate the 
prices on the invoice. Click Yes. 

14. Click Process. 

Time and Billing 
Simply Accounting  
Pro and higher 

If you are using Simply Accounting Pro or higher, you can keep 
track of the time you and your employees spend on various 
tasks or Activities by using the Time Slips window, and can 
create sales invoices based on the time spent. You can also pay 
your employees based on the time slips. 

 
The Time Slips window looks like this: 

 

Employee.  Enter the employee whose time you are recording 
for this time slip. You can specify which of your employees can 
enter time slips by assigning employees to Job Categories. 

Time Slip Number.  Enter a number if you want to use a number 
that is different from the one that automatically appears. 

Date.  Enter the date of this time slip. 

Time (hh:mm:ss).  Click Start to start the timer in the Time 
(hh:mm:ss) field, and click Stop to stop the timer. After you click 
Stop, you can continue or reset the timer. To apply the value in 
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the Time field to an item (activity) that is selected (checked), 
click Apply Time. 

Customer.  Enter the customer for whom the employee is 
performing the activity.  

Item.  Select the item (activity) that the employee is performing.  

Description.  Simply Accounting automatically displays the 
description from the item’s inventory record.  

Billing Status.  This is the status as a result of the time spent on 
the activity (item). The Billing Status field normally displays the 
value from the item’s inventory record (Billable, Non-Billable, or 
No Charge). You may be able to change the Billing Status field; 
for example, from Billable to No Charge. For a flat fee item, you 
could change the Billing Status field to In Progress. 

Selected (check mark).  If the item has a check mark in this 
field, it means that the value that is in the Time (hh:mm:ss) field 
will be added to the Actual Time and Billable Time fields of the 
item when you click Apply Time. 

Actual Time.  Enter the actual time that the employee spent on 
the item (activity). 

Billable Time.  This is the time associated with the Billing Status 
field. For example, if the status is No Charge, then the Billable 
Time is the amount of time that is non-chargeable. If the item’s 
status is Billable, and you change the Billable Time field, the 
billable amount also changes automatically. 

Billable Amount.  The amount that is to be charged for the time 
spent. Simply Accounting automatically calculates this amount 
based on the information from the item’s inventory record; 
however you can change the amount if you wish: 

■ If you change the amount of a billable item, then the Billable 
Time field automatically changes accordingly. 

■ If you change the amount of a flat fee item, the Billable Time 
field does not change. 
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■ If you change the amount of a flat fee item to zero, then the 
Status automatically changes to In Progress. 

Payroll Time.  The time that an employee is to be paid for the 
activity. 

Payroll Income.  The type of income that the employee will 
receive for the work completed, such as regular vs. overtime 
pay. 

Payroll Status.  If applicable, indicates whether an employee has 
been paid for this time billed. You cannot change this field. 

Exercise 34: Keeping Track of Time and Billing 

You can do this exercise only if you are using Simply 
Accounting Pro or higher. 

The management at Data Processing Services has decided to 
track how much time employees spend on the following 
activities, and to charge customers for the time spent: 

■ Data entry services (a billable service charged at $100 per 
hour). 

■ Consultation sessions (a billable service charged at a flat fee 
of $50). 

■ Photocopy services (normally not charged, but may be 
charged at $50 per hour). 

This exercise is in three parts. In part 1, you will prepare Simply 
Accounting to accept time and billing information. In part 2, you 
will use time slips to record the time spent on services. In part 3, 
you will create an invoice that bills a customer for the time spent 
on services. 

Part 1: Preparing to Use Time and Billing 

Before you can start tracking time, you must prepare your 
records in Simply Accounting. In Part 1, you will prepare 
account, inventory, and customer records. 
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Rename accounts 1. In the Home window, open the Accounts window (choose 
the Accounts icon). 

2. In the Accounts icon window, scroll to account 4310 
Service A, and double-click it to open the account record. 

3. In the Account description field, type Data Entry Revenue. 

4. Use the arrow buttons to scroll through the list of accounts. 
Select the following accounts and make these changes (after 
you change each account, if asked if you want to save your 
changes, click Yes): 

Change this: To this: 

4320 Service B 4320 Consultation Revenue 

4330 Service C 4330 Photocopy Revenue 

5. Close the Chart of Accounts Records and Accounts 
windows. 

Create inventory 
service records 

6. In the Home window, open the Inventory and Services 
window. 

7. Click the Create button on the toolbar and create an 
inventory service record for each of the following activities 
(items S001 to S003): 

 Field Record 1 Record 2 Record 3 

 Item Number: S001 S002 S003 

 Description: Data Entry Consultation 
Session 

Photocopying

 Type: Service Service Service 

In the checkbox Activity 
(Time and 
Billing): 

 
 
Yes 

 
 
Yes 

 
 
Yes 

On the Pricing tab Regular 
Selling Price: 

 
$100.00 

 
$50.00 

 
$50.00 
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 Field Record 1 Record 2 Record 3 

On the Linked tab  Revenue 
Account: 

4310 Data 
Entry 
Revenue 

4320 
Consultation 
Revenue 

4330 
Photocopy 
Revenue 

 Expense 
Account: 

Leave blank Leave blank Leave blank 

On the Time and Billing 
tab 

Unit of 
Measure: 

 
Hour 

 
Session 

 
Hour 

 Unit Is 
Related to 
Time: 

 
Defaults to 
Yes 

 
 
Yes 

 
Defaults to 
Yes 

 Relationship: Not 
applicable 

30 minutes 
per session 

Not 
applicable 

 The Service 
Activity Is: 

 
Billable 

 
Billable 

 
No Charge  

 Sometimes 
Charge For 
This Activity: 

 
Not 
applicable 

 
Not 
applicable 

 
 
Yes 

 Charges Are 
Based On: 

 
Billable Time 

 
Flat Fee  

 
Billable Time 

 Flat Fee = Not 
applicable 

1 session x 
Price 

Not 
applicable 

 Default 
Payroll 
Income: 

 
Non-payroll 

 
Non-payroll 

 
Non-payroll 

 Internal 
Service 
Activity: 

 
 
No 

 
 
No 

 
 
No 

8. Close the Inventory and Services Records window. 

You are now ready to start tracking time spent on the three 
activities. 
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Part 2: Tracking Time 

On January 15, 2015, Howard Ashcroft spent time on each of the 
three activities for different customers. You wish to record the 
time spent so that you can later create invoices to charge for the 
time. 

1. In the Home window, choose the Time Slips icon. 

2. Enter the following information: 

Employee: Ashcroft, Howard 
Time Slip No.: 100 
Date: 01-15-2015 
Customer: Software Corp. 
Item: S001 

Notice that the item is automatically selected (checked) 
which indicates that the item will have time applied to it if 
you click Apply Time. The window should look like this: 

 

3. In the Time (hh:mm:ss) field, type 220 (the time that Howard 
spent on this activity, 2 hours and 20 minutes). 

Note:  If you wanted to use the Timer to actually time an 
activity instead of merely typing in the time, click Start, and 
the clock starts in the Time (hh:mm:ss) field. To stop the 
clock, click Stop. 

4. Click Apply Time. 
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The value that was in the Time field (02:20:00) automatically 
appears in the Actual Time and Billable Time fields. Note 
that the item must have a check mark in order for time to be 
applied this way, and the check mark disappears after you 
apply the time. 

Note also that the Billable Amount field becomes 233.33. 
Simply Accounting automatically calculates the amount to 
be charged based on the information in the inventory record 
for activity S001. 

5. Move the cursor to the second line, and enter the following 
information: 

Customer: Action Line 
Item: S002 

Notice that values from item S002’s inventory record 
automatically appear in the Description, Billing Status, 
Billable Time and Billable Amount fields. 

6. In the Actual Time field, type 100 (for 1 hour). 

Notice that although Howard spent more than the 
designated “30 minutes per session” for a consultation 
session, the Billable Amount field remains at 50.00 because 
you have specified that consultation sessions are billed at a 
flat fee of $50.00. 

7. Move the cursor to the third line, and enter the following 
information: 

Customer: Action Line 
Item: S003 
Actual Time 010 (for 10 minutes) 

Note that the Billable Time field also becomes 00:10:00, and 
the Billing Status field is No Charge. 

On this occasion, however, you have decided to charge the 
customer for the photocopy services. Recall that when you 
created the inventory record, you had defined photocopy 
services as “no charge,” but you had also selected the 
Sometimes Charge For This Activity option. This enables 
you to charge fees on a non-chargeable item, as follows: 
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a) Highlight the Billing Status field and click the 
magnifying glass to display the Select Billing Status 
window. 

b) Select Billable. The Billing Status field changes to Billable  
and the Billable Amount field changes (recall that you 
created an inventory record for photocopy services 
specifying its rate at $50 per hour, so ten minutes of 
photocopy service is $8.33). 

The Time Slips window should look like this: 

 

8. To complete this time slip, print the time slip and click 
Record. 

If a warning about the time slip numbering sequence 
appears, click Yes to continue. 

9. Close the Time Slips window. 

This information is now available when you enter a sales order, 
quote, or invoice. 

To review or edit the time slip, open the Time Slips window and 
from the Time Slip menu, choose Look Up Time Slip to review 
only, or choose Adjust Time Slip to edit. To remove the time slip, 
first look up the time slip and then choose Remove Time Slip. 

To print the information on a report:  From the Home window, 
choose Reports, Time and Billing, then Billing, and one of the 
following reports:   
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■ Time by Customer 

■ Time by Employee 

■ Time by Activity 

Part 3: Entering a Sales Invoice 

You are now ready to create invoices to charge your customers 
for the services provided. 

1. In the Home window, choose Sales, Orders, And Quotes. 

2. In the Sold To field, select Action Line. 

 
Add Time Slip 
Activities 

3. From the Sales menu, choose Add Time Slip Activities (or 
click the Add Time Slip Activities icon from the toolbar). 

The Service Activities Selection window appears, and 
displays a list of activities to be billed: 

 

 
Include on 
Invoice 

4. Select items S002 and S003 by clicking the Include On 
Invoice (check mark ) column of each of those items. A 
check mark appears for each item. 

5. Click Add. 
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The Service Activities Selection window automatically 
closes, and items S002 and S003 appear in the details section 
of the invoice. Simply Accounting calculates and displays 
the total invoice amount as $66.49. The invoice should look 
similar to this (you may have to increase the window size to 
display all details):  

 

6. Click Process. 

Where To Now? 
Congratulations! You have completed the Simply Accounting 
Workbook. If you would like additional practice, complete the 
exercises in the next section, “Practice Session.” 

Practice Session 
The following exercises provide practice and reinforce a number 
of important concepts in Simply Accounting. 

1. There is an error in the address for your company, Data 
Processing Services. Change the address to read 2360 East 
Hastings St. 
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2. Data Processing Services has decided to supply laser 
printers. To accommodate this new inventory item, you 
must create several new accounts. First create the accounts, 
then create the inventory record.  

a) Add the following accounts:  

Account Number 1550 
Account Description:  Printers 
Account Type:  Group Account 
Omit From Financial Statements 

If Balance Is Zero:  
 
Yes 

Account Class: Inventory 
Account Number: 4050 
Account Description: Sales -- Printers 
Account Type: Group Account 
Omit From Financial Statements 

If Balance Is Zero: 
 
Yes 

Account Class: Revenue 
  
Account Number: 5050 
Account Description:  Cost -- Printers 

Account Type:  Group Account 
Omit From Financial Statements 

If Balance Is Zero:  
 
Yes 

Account Class: Cost of Goods Sold 

b) Create the new inventory record: 

Item Number: A20 
Item Description: Printer 
Stocking Unit of Measure: Each 
Minimum Level: 5 
Regular Selling Price: 428.50 
Preferred Selling Price: 411.50 
Asset: 1550 
Revenue: 4050 
Expense:  5050 
Variance: 5050 



Practice Session 

136    Simply Accounting 

 

SIM2005 CDN WB - PRINT.doc, printed on 10/12/2005, at 8:18:44 AM. Last saved on 
10/12/2005 8:15:00 AM. 

ACCPAC INTERNATIONAL, INC. Confidential 

3. Add a new customer:  

Portfolio Investments 
Jack Visser 
560 West 45th Avenue  
Vancouver 
British Columbia 
V2Q 1A8 
(604) 555 5525 
(604) 555 5526 

Early Payment Terms: Clear all fields 
Produce Statements For This 
 Customer: Yes 

4. Enter transactions to record the following business activities: 

a) On January 4, 2015, Data Processing Services purchased 
eight laser printers for $2,500 from Hart Computer 
Supplies (invoice number A352). You paid by cheque. 

b) On January 5, 2015, $500 was transferred from 
1055 Savings Bank Account to 1060 Chequing Bank 
Account. Enter 35 in the Source field. 

c) Data Processing Services sold a Web server to Portfolio 
Investments for $3,200 plus sales tax and 7 percent GST 
on January 5, 2015 (invoice number 440). The customer 
decided to pay later. 

d) On January 7, 2015, the bank returned cheque 
number 279, due to insufficient funds. This cheque was 
from Action Line for the partial payment of 
invoice A620. In the Receipts window, reverse the NSF 
cheque by recording a negative receipt. In the No. field, 
enter the original receipt number followed by NSF. 

5. To accommodate a management decision, make the 
necessary change to age customer invoices at 30, 60, and 
90-day intervals. 

6. How many toner cartridges does Data Processing Services 
have in stock on January 7? 
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7. Display a Miscellaneous Transactions report for the period 
of January 1, 2015, to January 7, 2015. 

8. The bookkeeper of Software Corp. calls to say he misplaced 
invoice 429. Display and reprint the invoice. 
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